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Introduction 
 
Qu’est-ce que CommView 
 
CommView est un programme pour contrôler les activités de Réseaux Internet et ses Réseaux Local Area Network (LAN), capable 
de capturer et d’analyser les paquets de réseau. CommView réunit l’information sur les données qui passent au travers de la 
connexion par modem RTC ou de la carte Ethernet et décode les données analysées. 
 
Avec CommView, vous pouvez visionner la liste des connexions réseaux et les statistiques IP vitales, puis examiner les paquets 
individuellement. Les paquets sont décodés au niveau le plus bas, avec une analyse complète des protocoles les plus communs. Un 
accès entier aux données non traitées est aussi fourni. Les paquets capturés peuvent être sauvegardés, afin d’enregistrer les 
fichiers pour une analyse future. Un système flexible de filtres rend possible l’abandon de paquets dont vous n’avez pas besoin ou la 
capture seule des paquets que vous désirez capturer. 
 
CommView est un outil utile pour les administrateurs de LAN, les professionnels en sécurité, les programmeurs de réseau ou toute 
personne souhaitant avoir une image nette du trafic circulant sur un ordinateur ou un segment LAN. Cette application est désignée 
pour les utilisateurs d’Internet, ainsi que pour les petits et moyens réseaux et peut opérer sur n’importe quel système Windows 
95/98/Me/NT/2000/XP. CommView requiert une carte Ethernet ou une carte réseau sans fil Ethernet supportant le pilote NDIS 3.0 
standard, ou une connexion par modem RTC standard. 
 
CommView procure le décodage complet des protocoles suivants: ARP, BCAST, BGP, BMP, DHCP, DIAG, DNS, EIGRP, FTP, GRE, 
HTTP, ICMP, ICQ, IGMP, IGRP, IPsec, IPv4, IPv6, IPX, GTP, HSRP, NCP, NDS, NetBIOS, NFS, NLSP, OSPF, POP3, PPP, PPPoE, 
RARP, RADIUS RDP, RIP RIPX, RSVP, RTSP, SAP, SER, SMB, SMTP, SNA SNMP, SOCKS, SPX, TCP, TELNET, TFTP, UDP, VTP, WAP, 
WDOG, 802.1Q, 802.1X. Plus de protocoles à venir sous peu! 
 
En supplément, notre nouvelle technologie de contrôle à distance permet aux utilisateurs de CommView de capturer le trafic de 
réseau sur n’importe quel ordinateur où Remote Agent opère, sans tenir compte de la location physique de l’ordinateur. Afin de 
prendre avantage de cette caractéristique unique, vous devez installer CommView Remote Agent, un ajout abordable pour 
CommView. 
 



 

 

 

Quoi de Neuf 
 
Version 3.4 
 

• Des nouveaux protocoles décodant des modules ont été ajoutés: BGP, EIGRP, IGRP, IPsec, GTP, HSRP, NFS, OSPF, 
RADIUS, RIP, SNA, VTP, WAP, 802.1Q, 802.1X. 

• Des nouveaux outils de gestion de fichiers Log (capturés) vous permettent de partager/concaténer les fichiers CCF qui 
ont été ajoutés. 

• Les fenêtres de Reconstruction de sessions TCP permettent maintenant de sauter à la session suivante entre les deux 
hôtes. 

• De nouvelles caractéristiques dans la fenêtres Statistics: bascule de bits par seconde à octets par secondes, indicateur de 
l’utilisation de la bande passante, graphiques de protocole IP ou de sous-protocole par nombre d’octets ou par nombre de 
paquets. 

• Un mode non furtif optionnel. 
• L’importation de fichiers capturés dans MS NetMon et NAI Sniffer pour les formats de Windows. 
• La surbrillance de syntaxe dans la fenêtre de formule avancée. 
• Une amélioration du support des thèmes de Windows XP. 
• Une réparation de bogue importante dans la fonction hex de règles avancées; cette fonction ne s’effectuait pas 

correctement pour les modèles de byte incluant 0x00. 
 
Version 3.3 
 

• Des règles avancées qui permettent de créer des filtres complexes en utilisant la logique simple de Boolean, une synthaxe 
facile à comprendre.  

• Des nouveaux protocoles décodant des modules ont été ajoutés: FTP, TFTP, SOCKS (v. 4,5), TELNET. 
• Encore une autre amélioration de performance. 
• De nouvelles caractéristiques du Packet Generator: support de glisser-et-déposer de n’importe quel format de paquet, la 

génération de paquets à haute vitesse (plus de 5,000 paquets/sec) et la capacité d’envoyer plusieurs paquets différents 
d’un simple clic de souris.  

• Option de concaténation des fichiers Log (capturés) en un seul fichier lorsque le programme arrête la capture. 
• Nouveaux formats d’exportation: fichiers séparés par des points-virgules avec ou sans données hexadécimales.  
• Vous pouvez maintenant sauvegarder les paquets en différents formats (CCF, ENC, etc.) directement, sans avoir à 

charger les fichiers capturés dans le Log Viewer au préalable. 
• Les tables d’hôtes LAN peuvent maintenant traiter plus de 1,000 adresses MAC et IP.  
• Une option "Taille" des colonnes est disponible dans la liste de paquets. 
• Vous pouvez définir les adresses réseau et les masques subnet pour les adresses IP que vous voulez voir traitées par le 

programme localement. 
• Plusieurs améliorations mineures et réparations de bogues. 

 
Version 3.2 
 

• De nouveaux protocoles décodant les modules ont été ajoutés: SNMP (v. 1,2,3), IPv6, ICQ, GRE, RDP. 
• Une amélioration majeure de la performance lorsque ouvrant/important: les fichiers sont chargés jusqu’à 25 fois plus 

rapidement. 
• Un usage moins grand du CPU. 
• Des statistiques NIC étendues, telles que les collisions et erreurs CRC, sont disponibles. 
• La possibilité d’appliquer des règles aux données pré-capturées dans le Log Viewer. 
• Un dialogue Find Packet amélioré. 

 
Version 3.1 
 

• De nouveaux protocoles décodant les modules ont été ajoutés: DHCP, DNS, HTTP, POP3, RTSP, SMTP. 
• Une nouvelle et unique technologie de contrôle à distance. 
• La possibilité d’ajouter jusqu’à 4 protocoles conventionnels au registre de sous-protocoles IP. 
• La possibilité d’importer des fichiers capturés en format Tcpdump (libcap). 
• Plus d’options de configuration ajoutées. 
• Plusieurs améliorations mineures et réparations de bogues. 

 
Version 3.0 
 

• Un nouveau décodeur de protocoles; supportant maintenant ARP, BCAST, BMP, DIAG, ICMP, IGMP, IPv4, IPX, NCP, NDS, 
NetBIOS, NLSP, PPP, PPPoE, RARP, RIPX, RSVP, SAP, SER, SMB, SPX, TCP, UDP, WDOG. Plus de protocoles à venir sous 
peu. 

• Support pour les adaptateurs d’Ethernet (802.11b) sans fil. 
• Le programme est prêt pour Windows XP (testé avec RC1). 
• Le Packet Generator peut maintenant envoyer des paquets via une connexion par modem RTC sur Windows 2000/XP. 
• Un décodeur de protocoles et un correcteur de somme de contrôle (checksum) ont été ajoutés au Packet Generator. 
• L’option d’opérer de multiples instances de CommView pour contrôler plusieurs adaptateurs simultanément. 
• Les statistiques IP peuvent être incluses dans le Statistics Report. 
• Un nouvel hôte de LAN par table d’adresses IP a été ajouté à la fenêtre Statistics. 
• La fenêtre TCP Reconstruction permet d’exclure/inclure les données basées sur la direction du paquet. 
• La possibilité de filtrer les paquets basés sur les flags TCP. 
• Le programme peut opérer en mode invisible. 



 

 

• La possibilité de partager les données de CommView avec votre propre application utilisant une interface TCP/IP simple. 
• L’onglet Packets vous permet de sélectionner de multiples paquets. 

 
Version 2.6 
 

• Les alias peuvent être assignés aux adresses IP. 
• Des règles courantes peuvent être appliquées à la fenêtre Statistics et son onglet Report. 
• Décodage de PPPoE. 
• La fenêtre TCP Session Reconstruction, maintenant non-modale, vous permet d’avoir plusieurs fenêtres ouvertes avec 

différentes sessions. 
• Des améliorations mineures à l’interface et réparations de bogues. 

 
 
Version 2.5 
 

• Un support complet de glisser-déposer: vous pouvez maintenant glisser les statistiques IP, les paquets individuels et les 
graphiques, puis les déposer sur votre bureau ou dans n’importe quel dossier. Vous pouvez glisser les fichiers capturés 
(CCF, ENC, or BFR) et les déposer dans l’application. 

• Packet Size Distribution chart et LAN Hosts Tables ont été ajoutés à la fenêtre Statistics. 
• Génération de rapport automatique ou manuelle: toutes les données statistiques peuvent être sauvées en HTML ou en 

rapports délimités par des points-virgules. (Voir l’onglet "Report" dans la fenêtre Statistics.) 
• La fenêtre TCP Session Reconstruction vous permet maintenant de visionner les données en HTML et en EBCDIC, en 

addition d’ASCII et d’HEX. 
 
Version 2.4 
 

• TCP session reconstruction. 
• Les alias peuvent être assignés aux adresses MAC. 
• Identificateur de marchand NIC (NIC Vendor Identifier). 
• Plus de colonnes sont disponibles dans les onglets "IP Statistics" et "Packets". 
• Les colonnes sur les onglets "Packets" et les "IP Statistics" peuvent être cachées. 
• Les paquets ARP/RARP sont décodés. 
• Les jokers (wildcards) peuvent être utilisées dans les règles d’adresses IP. 
• L’option "Both" dans  la capture de règles est disponible, en addition aux options "From" et "To". 
• Les onglets avec règles actives sont maintenant disposés en caractère gras. 
• Les sorties de données de paquets peuvent être suspendues/résumées. 
• Plusieurs alternatives de mise en page des statistiques IP sont disponibles. 
• Autres améliorations mineures. 

 
 
Version 2.3 
 

• Support des connexions par modem RTC sous Windows 2000. 
 
 
Version 2.2 
 

• Les entêtes de MAC, IP, et TCP/UDP/ICMP sont colorées. 
• Le contenu de l’onglet IP Statistics peut être sauvegardé en fichier HTML. 
• L’ajout de Packet Generator vous permet d’envoyer des paquets. 
• Les configurations de règles peuvent être sauvegardées/chargées. 
• Les règles en texte peuvent maintenant être sensibles à la casse. 
• Le dialogue de Find Packet Contents amélioré. 
• Bogue réparé: les problèmes avec le démarrage du pilote (starting the driver) sur les systèmes localisés de Windows 

2000 ont été résolus. 
 
 
Version 2.1 
 

• Log Viewer: Vous pouvez maintenant charger et explorer les fichiers capturés, tout comme vous le faites avec les 
données capturées en temps réel. 

• Vous pouvez importer et exporter des fichiers capturés de/à NIC Observer ou de fichiers en format NAI Sniffer. 
• Les nombres de ports peuvent être déployés en noms de service. 
• Une nouvelle option "Jump To" vous permet de retrouver rapidement des paquets allant/venant d’adresse IP données. 
• Quelques améliorations à l’interface. 
• Bogue réparé: les versions précédentes montraient une somme de contrôle (checksum) UDP incorrecte. 

 
 
Version 2.01 
 

• Support de Windows 2000. 
 
 
Version 2.0 Final 
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• Performance améliorée sur les systèmes Windows NT. 
• Quelques bogues trouvés dans 2.0 Beta ont été réparés. 

 
 
Version 2.0 Beta 
 

• Support de Windows NT. 
• Plus d’informations statistiques. 

 
  
Version 1.0 Final 
 

• Nouvelles fonctions: Find Packet et Go to Packet Number. 
• Nouveaux filtres: Capturer/ignorer les paquets basés sur les adresses MAC et la direction des paquets. 
• Statistiques: Histogrammes de Paquets par seconde et Bytes par seconde, graphiques de distribution de protocoles et de 

sous-protocoles IP. 
• Bogue réparé: Le filtre de texte dans la version 1.0 Beta pouvait parfois capturer les paquets qui ne contenaient pas de 

texte spécifique; ce problème a été réglé. 



 

 

 

Licence d’utilisation 
 
Veuillez s’il-vous-plaît lire méticuleusement les termes et les conditions suivants avant d’utiliser ce logiciel. Votre utilisation de ce 
logiciel indique votre consentement à cette licence d’utilisation. Si vous n’êtes pas d’accord avec les termes de cette licence, vous 
devez enlever ce logiciel de vos périphériques de stockage et cesser l’utilisation de ce produit. 
 
Tous Droits Réservés 
Ce logiciel est légalement déposé 1999-2002 par TamoSoft, Inc. CommView est une marque déposée de TamoSoft, Inc. L’utilisation 
et les droits réservés de ce logiciel sont gouvernés par des traités internationaux de droits réservés et légalement déposés. 
TamoSoft, Inc. conserve les titres complets et les droits de ce logiciel et de cette documentation, et en aucun cas l’accord de licence 
ne diminue les droits de propriété intellectuelle de TamoSoft, Inc. Vous ne devez pas redistribuer les codes d’enregistrement 
procurés—sur papier, éléctroniquement, ou sous toute autre forme. 
 
Version d’Évaluation 
Ce logiciel n’est pas gratuit. Vous êtes de ce fait licencié pour utiliser ce logiciel pour fins d’évaluation, sans frais pour une période 
de 30 jours. Utiliser ce logiciel après cette période d’évaluation viole les lois de droits réservés et peut résulter en de sévères 
pénalités civiles et criminelles.  
 
Version Enregistrée (Licenciée) 
Une copie enregistrée de ce logiciel peut être utilisée par un seule personne qui utilise personnellement ce logiciel sur un ou 
plusieurs ordinateurs, ou elle peut être installée sur une station de travail simple utilisée non-simultanément par plus d’une 
personne, mais pas les deux. Ce logiciel peut être installé sur un serveur de réseau, munie d’une licence séparée, appropriée pour 
l’utilisation de ce logiciel et reçue par TamoSoft, Inc. pour chacun des terminaux ayant accès à ce logiciel.  
 
Avis de Non-Responsabilité 
CE LOGICIEL EST FOURNI "TEL QUEL" SANS GARANTIE D’AUCUNE SORTE, SOIT EXPRIMÉE OU IMPLIQUÉE, INCLUANT, MAIS 
NON-LIMITÉE AUX, LES GARANTIES DE MARCHANDAGE OU DE FONCTIONNALITÉ POUR DES FINS PARTICULIÈRES. EN AUCUN 
CAS TAMOSOFT, INC. NE SERA RESPONSABLE ENVERS VOUS POUR TOUT DOMMAGE, INCLUANT LES DOMMAGES ACCIDENTELS 
OU INDIRECTS, RÉSULTANT DE L’UTILISATION DE CE LOGICIEL, MÊME SI AVISÉ(E) DE LA POSSIBILITÉ DE TELS DOMMAGES. 
VOUS CONSENTEZ ET ACCEPTEZ QUE VOUS AVEZ LU CETTE LICENCE, QUE VOUS L’AVEZ COMPRISE ET QUE VOUS ACCEPTEZ 
D’ÊTRE OBLIGÉ(E) PAR SES TERMES. 
 
Loi Gouvernante 
Cette Licence d’utilisation sera gouverné par les lois de la République de Chypre. 
 
Distribution 
Ce logiciel peut être distribué gratuitement dans sa forme originale non-modifiée et non-enregistrée. La distribution doit inclure tous 
les fichiers de sa distrbution originale. Les distributeurs ne peuvent charger aucun frais pour sa distribution. Toute personne 
distribuant ce logiciel pour quelque sorte de rémunération doit d’abord nous contacter pour une autorisation. 
 
Autres Restrictions 
Vous ne pouvez pas modifier, faire de l’inginérie inverse, décompiler ou désassembler ce logiciel en aucune façon, incluant changer 
ou enlever tout message ou fenêtre. 
 
Windows est une marque enregistrée déposée de Microsoft Corporation. Toutes les autres marques déposées et les logos et marques de service sont 
la propriété de leurs propriétaires respectifs. 
 



 

 

 
Utilisation de CommView 
 
Survol 
 
L’interface du programme consiste en quatre onglets qui vous permettent de visionner les données et de performer des actions 
variées avec les paquets capturés. Pour commencer à capturer les paquets, sélectionnez un adaptateur de réseau à partir de la liste 
du menu déroulant sur la barre d’outils, puis cliquez sur le bouton Start Capture ou sélectionnez File = > Start Capture à partir 
du menu. Si le trafic du réseau passé au travers de l’adaptateur de réseau est sélectionné, CommView va commencer à déployer les 
informations.  
 
Main Menu 
 
File 
Start/Stop Capture – commencer/arrêter de capturer des paquets. 
Suspend/Resume Packet Output – arrêter/résumer les données de paquets en temps réel sur le 2ème onglet. 
Remote Monitoring Mode – montrer/cacher la barre d’outils de remote monitoring . 
Save IP Statistics As – permet de sauvegarder le contenu de l’onglet statistiques IP en rapport HTML. 
Save Packet Log As –permet de sauvegarder le contenu de l’onglet Packets en différents formats. Utilisez l’onglet Logging pour 
des options avancées de sauvegarde. 
Log Viewer – ouvre une nouvelle fenêtre de Log Viewer . 
Clear IP Statistics – efface la table IP Statistics (1er onglet). 
Clear Packet Buffer – efface le contenu de la mémoire tampon du programme et de la Packets List (2ème onglet). 
Performance Data – déploie les statistiques de la performance du programme: le nombre de paquets capturés et abandonnés par 
le logiciel de pilotage. Cette commande n’est pas disponible sous Windows 95/98/Me. 
Exit – ferme le programme. 
 
Search 
Find Packet – montre un dialogue qui vous permet de trouver les paquets qui correspondent à un texte spécifique. 
Go to Packet Number – montre un dialogue qui vous permet de sauter à un paquet avec le nombre spécifié. 
 
View 
Statistics – montre une fenêtre avec des statistiques de transfert de données et  des statistiques de distribution de protocole. 
Port Reference – montre une fenêtre avec une information de référence sur le port. 
Log Directory – ouvre le repértoire où les logs sont sauvegardés par défaut. 
IP Statistics Columns – montrer/cacher les colonnes de l’onglet statistiques IP.  
Packets Columns – montrer/cacher les colonnes de l’onglet Packets. 
 
Tools 
Packet Generator – ouvre la fenêtre du Packet Generator . 
Reconstruct TCP Session – vous permet de reconstruire une session TCP en partant du paquet sélectionné; ouvre une fenêtre 
qui déploie la conversation entière entre deux hôtes. 
NIC Vendor Identifier – ouvre une fenêtre où vous pouvez  identifier un marchand d’adaptateur de réseau par adresse MAC. 
 
Settings 
Fonts – montre le sous-menu pour configurer les fontes des éléments de l’interface. 
MAC Aliases – ouvre une fenêtre où vous pouvez assigner des alias faciles à mémorer aux adresses MAC. 
IP Aliases – ouvre une fenêtre où vous pouvez assigner des alias faciles à mémorer aux adresses IP. 
Options – ouvre la fenêtre d’Options où des options additionnelles avancées peuvent être configurées. 
 
Rules 
Save Current Rules As – vous permet de sauvegarder les règles courantes de configuration à un dossier. 
Load Rules From – vous permet de charger des règles de configuration préalablement sauvegardées d’un dossier. 
Reset All – efface toutes les règles existantes (si lieu). 
 
Help 
Contents – déploie l’aide de CommView.  
Search For Help On …  – montre l’index d’aide de CommView. 
About – montre l’information sur le programme. 
 
 
Presque tous les éléments de l’interface ont un menu sensible au contexte (pop-up) qui peut être invoqué en cliquant sur le bouton 
droit de la souris et plusieurs commandes sont disponibles seulement à travers ces menus. 
 
Le premier onglet est utilisé pour déployer une information détaillée sur les connexions de réseau (protocole IP seulement) de votre 
ordinateur. Pour plus d’informations, consultez IP Statistics. 
 
Le second onglet est utilisé pour visionner les paquets de réseau capturés et déployer une information détaillée sur un paquet 
sélectionné. Pour plus d’informations, consultez Packets. 
 
Le troisième onglet vous permet de sauvegarder des paquets capturés dans des dossiers. Pour plus d’informations, consultez 
Logging. 
 



 

 

Le quatrième onglet est pour configurer les règles qui vous permettent de capturer/ignorer des paquets, basés sur des critères 
variés, tel que les adresse IP ou  le nombre de port. Pour plus d’informations, consultez Rules. 
 
Vous pouvez modifier certaines des configurations, tells que les fontes, les couleurs, ainsi que la taille de la mémoire tampon en 
sélectionnant Settings à partir du menu. Pour plus d’informations, consultez Setting Options. 
 



 

 

 
IP Statistics 
 
Ce onglet est utilisé pour déployer une information détaillée sur les connexions de réseau (protocole IP seulement) de votre 
ordinateur. Pour commencer à capturer des paquets, sélectionnez File = > Start Capture dans le menu ou cliquez le bouton 
correspondant sur la barre d’outils. 
 

 
 
La définition de la table columns est expliquée ci-dessous: 
 
Local IP – montre l’adresse IP locale. Pour les paquets entrants, c’est l’adresse de destination IP; pour les paquets sortants et 
passant à travers, c’est l’adresse source IP. 
Remote IP – montre l’adresse à distance IP. Pour les paquets entrants, c’est l’adresse source IP; pour les paquets sortants et 
passant à travers, c’est l’adresse de destination IP. 
In – montre le nombre de paquets reçus. 
Out – montre le nombre de paquets envoyés. 
Direction – montre la direction de la session. La direction est déterminée en se basant sur la direction du premier paquet reçu de 
et envoyé à l’adresse à distance IP.  
Sessions – montre le nombre de sessions TCP/IP établies. Si aucune connexion TCP n’a été établie (la connexion a échoué, ou le 
protocole est UDP/IP ou ICMP/IP), cette valeur est de zéro.   
Ports – liste les ports d’ordinateurs à distance utilisés durant la connexion TCP/IP ou la tentative de connexion. Cette liste peut être 
vidée si le protocole n’est pas TCP/IP. Les ports peuvent être déployés en valeurs numériques et en noms de service 
correspondants. Pour plus d’informations, consultez Setting Options. 
Hostname – montre le nom d’hôte d’ordinateur à distance. Si le nom d’hôte ne peut être résolu, cette colonne est vide. 
Bytes – montre le nombre de bytes transmis durant la session.  
Last packet – montre le temps du dernier paquet envoyé/reçu durant la session.  
 
Vous pouvez montrer ou cacher les colonnes individuellement en cliquant l’item correspondant dans le menu View =>IP 
Statistics Columns. 
 
 
Commandes de Menu 
 
En cliquant le bouton droit de la souris sur IP Statistics list, un menu est déployé avec les commandes suivantes: 
 
Copy  – copie l’adresse IP locale, l’adresse à distance IP ou le nom d’hôte sur le presse-papiers. 
Show All Ports – déploie une fenêtre avec une liste complète des ports utilisés en communiquant entre la paire sélectionnée 
d’adresses IP. Ceci est très utile lorsque plusieurs ports ont été utilisés, et qu’ils ne correspondent pas à la colonne sélectionnée. 
Data Transfer – déploie une fenêtre avec l’information du volume de transfert de données entre la paire d’adresses IP 
sélectionnée et le temps du dernier paquet. 
Jump To – vous permet de sauter rapidement au premier/dernier paquet avec l’adresse source ou destination IP sélectionnée; le 
programme déploiera l’onglet Packets et positionnera le curseur de la souris au paquet qui correspond aux critères.  
SmartWhois – envoie l’adresse à distance IP sélectionnée à SmartWhois, si ce dernier est installé sur votre système. SmartWhois 
est une application autonome développée par notre compagnie et capable d’obtenir l’information sur n’importe quelle adresse IP ou 



 

 

nom d’hôte dans le monde entier. Elle procure automatiquement les informations associées à une adresse IP, telles que le domaine, 
le nom de réseau, le pays, l’état ou la province, ainsi que la ville. Ce programme peut être téléchargé à partir de notre site. 
Create Alias – ouvre une fenêtre où vous pouvez assigner des alias faciles à mémorer aux addresses IP. 
Save IP Statistics As – vous permet de sauvegarder le contenu de l’onglet IP Statistics en rapport HTML. 
Clear IP Statistics – efface la table. 
More Statistics  -- montre une fenêtre avec des statistiques de transfert de données et des statistiq ues de distribution de 
protocole. 
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Packets 
 
Cet onglet est utilisé pour lister tous les paquets de réseau capturés et déployer l’information détaillée sur un paquet sélectionné. 
 

 
 
La table supérieure déploie la liste des paquets capturés. Utilisez cette liste pour sélectionner un paquet que vous voulez voir 
déployé et analysé. Lorsque vous sélectionnez un paquet en cliquant dessus, d’autres volets montrent de l’information sur le paquet 
sélectionné. 
 
La définition de la table columns est expliquée ci-dessous: 
 
No – un nombre unique par paquet. Si vous faites filtrer les paquets par CommView en utilisant l’onglet Rules, quelques-uns des 
paquets ne seront pas capturés, mais seront toujours enregistrés.  Alors, vous pouvez remarquer que les paquets n’apparaissent 
pas dans un ordre numérique séquentiel. 
Protocol – montre le protocole des paquets.  
MAC Addresses – montre les adresses source et destination MAC et la direction des paquets.  
 
Exemples: 
 
22:22:22:22:22 => 33:33:33:33:33 est un paquet entrant de 22:22:22:22:22 à 33:33:33:33:33. 
 
22:22:22:22:22 <= 33:33:33:33:33 est un paquet entrant de 33:33:33:33:33 à 22:22:22:22:22. 
 
44:44:44:44:44 <=> 55:55:55:55:55 est un paquet passant à travers de 44:44:44:44:44 à 55:55:55:55:55. 
 
55:55:55:55:55  <=> 44:44:44:44:44 est un paquet passant à travers de 55:55:55:55:55 à 44:44:44:44:44. 
 
IP Addresses – montre les adresses source et destination IP (lorsqu’applicable) et la direction des paquets. 
Ports – montre les ports source et destination (lorsqu’applicable) et la direction des paquets. Les ports peuvent être déployés en 
valeurs numériques ou comme noms des service correspondants. Pour plus d’informations, consultez Setting Options. 
Time / Delta – montre les paquets absolus ou temps delta. Le temps delta est la différence entre le temps absolu des deux 
derniers paquets. Vous pouvez passer de l’absolu au temps delta en cliquant View =>Packets Columns =>Show Time As.  
Size – montre la taille des paquets en bytes. Cette colonne n’est pas visible par défaut. 
 
Les colonnes individuelles peuvent être montrées ou cachées en cliquant l’item correspondant dans le menu View =>Packets 
Columns. Le paquet sortant peut être suspendu en cliquant File =>Suspend Packet Output. Dans le mode suspendu, les 
paquets sont capturés, mais pas déployés, sur l’onglet Packets. Ce mode est utile lorsque vous être interessé(e) seulement dans 
les statistiques, plutôt que dans les paquets individuels. Pour résumer le déploiement des paquets en temps réel, cliquez File 
=>Resume Packet Output.  
 
Le volet du milieu déploie le contenu indéfini, soit en notation hexadécimale ou en texte simple. En texte simple, les caractères 
non-imprimables sont remplacés par des points. 
 
Le volet inférieur déploie l’information de paquet décodée pour le paquet sélectionné. Cette information inclut des données vitales 
qui peuvent être utilisées par des professionnels de réseau. Cliquer le bouton droit de la souris sur le volet invoque le menu 



 

 

contextuel (pop-up) qui vous permet d’écraser/agrandir tous les nœuds, ou bien de copier tous les noeuds ou seulement ceux 
sélectionnés. Vous pouvez changer la position de la fenêtre Decoder en cliquant sur un des trois boutons sur le volet inférieur (vous 
pouvez avoir une fenêtre Decoder alignée vers le bas, la droite ou la gauche). 
 
 
Commandes de Menu 
 
Cliquer le bouton droit de la souris sur la liste de paquets ouvre un menu avec les commandes suivantes: 
 
Reconstruct TCP Session – vous permet de reconstruire une session TCP en partant du paquet sélectionné; une fenêtre ouvre et 
déploie la conversation entière entre deux hôtes. 
Create Alias – ouvre une fenêtre où vous pouvez assigner un alias facile à mémorer à l’adresse MAC ou IP sélectionnée. 
Copy Address – copie l’adresse source MAC, l’adresse de destination MAC, l’adresse source IP ou l’adresse de destination IP au 
presse-papiers. 
Copy Packet – copie les données indéfinies du paquet sélectionné sur le presse-papiers. 
Send Packet – montre la fenêtre Packet Generator qui vous permet d’envoyer encore le paquet sélectionné. Vous pouvez aussi 
modifier le contenu du paquet avant de l’envoyer. 
Save Packet(s) As – sauvegarde le contenu du(des) paquet(s) sélectionné(s) dans un fichier. Le dialogue Save As vous permet de 
sélectionner le format à être utilisé lorsque vous sauvegardez des données de la liste déroulante.  
Clear Packet Buffer – efface le contenu de la mémoire tampon du programme. La liste de paquets sera effacée, puis vous ne 
serez pas capable de visionner les paquets précédemment capturés par le programme. 
 
Vous pouvez aussi glisser-déposer le(s) paquet(s) sélectionné(s) sur le bureau. 



 

 

 
Logging 
 
Ce onglet est utilisé pour sauvegarder les paquets capturés dans un dossier sur le disque. CommView sauvegarde les paquets dans 
son propre format avec l’extension .CCF (CommView Capture Files). Vous pouvez ouvrir et visionner ces fichiers en tout temps en 
utilisant Log Viewer ou vous pouvez simplement double-cliquer sur tout fichier CCF pour le charger et le décoder. 
 
Save Log 
 
Utilisez ce cadre pour sauvegarder manuellement des paquets capturés dans un dossier. Vous pouvez soit sauvergarder tous les 
paquets stocker actuellement dans la mémoire-tampon, soit sauvegarder seulement une partie de ceux-ci en-dedans d’une étendue  
donnée. Les champs To et From vous permettent de configurer l’étendue nécessaire basée sur le nombre de paquets, tel que 
montré sur l’onglet Packets. Cliquez Save As … pour sélectionner un nom de fichier. 
 
Auto-saving 
 
Cochez cette case pour que le programme sauvegarde automatiquement les paquets capturés au fur et à mesure qu’ils arrivent. 
Utilisez le champ Maximum directory size pour limiter la taille totale des documents capturés stockés dans le Log Directory. Si 
la taille totale des documents excède la limite, le programme va automatiquement supprimer les plus anciens documents du 
répertoire. Pour changer la configuration par défaut du Log Directory, cliquez la case Save files to et sélectionnez un fichier 
différent. Les paquets sont capturés en groupe, à raison de 500 paquets dans chaque fichier. Si vous préférez avoir tous les fichiers 
générés de la session de capture en cours concaténés en un seul fichier, cochez la case Concatenate files when capturing is 
stopped. Le programme créera alors un seul fichier lorsque vous arrêtez la capture.    
 
 Un fichier log contenant 500 paquets est d’une taille approximative de 500 kilobytes. 
 
IMPORTANT: Si vous planifier avoir une capture importante de documents stockés pour une longue période de temps, ne les gardez 
pas dans le Log Directory par défaut: il y a de bonnes chances qu’ils seront automatiquement supprimés, au fur et à mesure que de 
nouveaux fichiers seront sauvegardés. Déplacez ce document dans un dossier different pour le préserver. 
 
Veuillez s’il-vous-plaît prendre note que le programme ne sauvegarde pas chaque paquet individuellement à leur arrivée. Les 
paquets sont sauvegardés en groupe de 500. Ceci veut dire que si vous visionnez le fichier log en temps réel, il se peut qu’il ne 
contienne pas les 500 derniers paquets. Pour que le programme abandonne immédiatement la mémoire tampon dans le fichier log, 
cliquez soit Stop Capture ou décochez la case Auto-saving. 
 
Gestion d’enregistrement 
 
Utilisez ce cadre pour concaténer manuellement de multiples fichiers CCF en un seul large fichier, en cliquant sur le bouton 
Concatenate Logs, ou partagez les fichiers CCF qui sont de trop large taille en de plus petits blocs, en cliquant sur le bouton Split 
Logs. Le programme vous guidera alors à travers le processus, et vous serez capable d’indiquer la taille désirée des fichiers 
sortants. 



 

 

 
Viewing Logs 
 
Log Viewer est un outil pour visionner et explorer les documents capturés créés par CommView et plusieurs autres analyseurs de 
paquets. Il a la fonctionnalité de l’onglet Packets sur la fenêtre principale du programme, mais contrairement à l’onglet Packets, Log 
Viewer déploie les paquets chargés à partir des dossiers sur le disque, au lieu des paquets capturés en temps réel.  
 
Pour ouvrir Log Viewer, cliquez File => Log Viewer dans le menu principal du programme, ou double-cliquez simplement sur 
n’importe lequel des dossiers capturés par CommView et précédemment sauvegardés. Vous pouvez ouvrir autant de fenêtres Log 
Viewer que vous le désirez, et chacune d’elles peut être utilisée pour explorer un ou plusieurs dossiers sauvegardés. 
 
Log Viewer peut être utilisé pour explorer les dossiers capturés créés par d’autres analyseurs de paquets et pare-feu personnels. La 
version courante peut importer des fichiers dans le Network Instruments Observer®, Network Associates Sniffer® pour 
DOS/Windows, Microsoft NetMon, ainsi qu’en format Tcpdump (libcap). Ces formats sont aussi utilisés par un certain nombre 
d’applications de tierce parti. Log Viewer a la capacité d’exporter des données de paquets en créant des dossiers dans le the 
Network Instruments Observer® et le Network Associates Sniffer® pour formats DOS, aussi bien que le format natif de CommView. 
 
Utiliser Log Viewer est similaire à utiliser l’onglet Packets de la fenêtre principale; s’il-vous-plaît, consultez le chapitre Packets si 
vous avec besoin d’informations détaillées. 
 
Menu de Log Viewer 
 
File 
Load CommView Logs – ouvre et charge un ou plusieurs dossiers capturés CommView. 
Import Logs – vous permet d’importer des dossiers capturés créés par d’autres analyseurs de paquets. 
Export Logs – vous permet d’exporter les paquets déployés pour capturer des dossiers dans plusieurs formats. 
Clear Window – efface la Packet List. 
Close Window – ferme la fenêtre. 
 
Search 
Find Packet – montre un dialogue qui vous permet de trouver des paquets correspondant à un texte spécifique. 
Go to Packet Number – montre un dialogue qui vous permet de sauter à un paquet à l’aide d’un nombre spécifié. 
 
Rules 
Apply – applique vos règles courantes aux paquets déployés dans le Log Viewer. En résultat, lorsque vous utilisez cette 
commande, le programme va supprimer les paquets qui ne correspondent pas aux règles courantes. Notez que ceci ne modifiera 
pas le dossier sur le disque. 
From File … - fait la même chose que la commande Apply, mais vous permet d’utiliser les règles d’un dossier .RLS précédemment 
sauvegardé, au lieu des règles courantes. 
 
Observer® et Sniffer® sont des marques déposées enregistrées de Network Instruments, LLC et Network Associates, Inc. respectivement. 
 



 

 

 
Rules 
 
Cet onglet vous permet de configurer des règles pour capturer des paquets. Si une ou plusieurs règles sont configurées, le 
programme filtre les paquets en se basant sur ces règles et déploie seulement les paquets qui correspondent à ces règles. Notez 
que CommView n’est pas un pare-feu, et que lorsque vous utilisez ces règles, les paquets sont toujours procédés par le système 
d’exploitation; ils ne sont seulement pas déployés et enregistrés par CommView. Si une règle est configurée, le nom de l’onglet 
correspondant est déployé en fonte à caractère gras. 
 
Vous pouvez sauvegarder vos configuration(s) de règles dans un dossier et les charger en utilisant Rules du menu du programme. 
 
Puisque le trafic LAN peut souvent générer un nombre élevé de paquets, il est recommandé d’utiliser des règles pour filtrer vers 
l’extérieur les paquets inutiles. Ceci peut considérablement réduire le nombre de ressources du système consumées par le 
programme. Si vous désirez activer/désactiver une règle, sélectionnez l’onglet approprié sur le côté gauche de la fenêtre (e.g. IP 
Addresses ou Ports), et cochez ou décochez la case décrivant la règle (Enable IP Address rules ou Enable port rules). Il y a 
sept types de règles qui peuvent être utilisés: 
 
 



 

 

Protocols & Direction 
  
Vous permet d’ignorer ou de capturer des paquets basés sur l’Ethernet (Layer 2), les protocoles IP (Layer 3) ou sur la direction des 
paquets.  
 

 
 
Cet exemple démontre comment faire pour que le programme capture seulement les paquets ICMP et UDP entrants et sortants. 
Tous les autres paquets dans la famille IP vont être ignorés; tous les paquets passant à travers vont aussi être ignorés. 
 
 



 

 

MAC Addresses 
 
Vous permet d’ignorer ou de capturer les paquets basés sur les addresses MAC (hardware). Entrez une adresse MAC dans le champ 
Add Record, sélectionnez la direction (From, To, ou Both), puis cliquez Add MAC Address. La nouvelle règle va être déployée. 
Maintenant, vous pouvez sélectionner l’action à prendre lorsqu’un nouveau paquet est procédé: le paquet peut être ou bien 
capturé, ou bien ignoré. Vous pouvez aussi cliquer sur le bouton MAC Aliases pour obtenir une liste des alias; double-cliquez sur 
l’alias que vous souhaitez ajouter, puis l’adresse MAC correspondante apparaîtra dans la boîte d’entrée. 
 

 
 
Cet exemple démontre comment faire pour que le programme ignore les paquets qui viennent de 0A:DE:34:0F:23:3E. Tous les 
paquets venant d’adresses MAC différentes vont être capturés. 
 
 



 

 

IP Addresses 
 
Vous permet d’ignorer ou de capturer les paquets basés sur les addresses IP. Entrez une adresse IP dans le champ Add Record, 
sélectionnez la direction (From, To, ou Both), puis cliquez Add IP Address. Vous pouvez utiliser des jokers (wildcards) pour 
spécifier des blocs d’adresses IP. La nouvelle règle va être déployée. Maintenant, vous pouvez sélectionner l’action à prendre 
lorsqu’un nouveau paquet est procédé: le paquet peut être ou bien capturé, ou bien ignoré. Vous pouvez aussi cliquer sur le bouton 
IP Aliases pour obtenir une liste des alias; double-cliquez sur l’alias que vous souhaitez ajouter, puis l’adresse IP correspondante 
apparaîtra dans la boîte d’entrée. 
 

 
 
Cet exemple démontre comment faire pour que le programme capture les paquets qui vont à 63.34.55.66, qui vont à et viennent de 
207.25.16.11 et viennent de toutes les adresses comprises entre 194.154.0.0 et 194.154.255.255. Tous les paquets venant 
d’adresses différentes ou allant vers d’autres adresses vont être ignorées. Puisque les adresses IP sont utilisées dans protocole IP, 
une telle configuration va faire que le programme ignore automatiquement les paquets non IP.  
 



 

 

Ports 
 
Vous permet d’ignorer ou de capturer les paquets basés sur les ports. Entrez un nombre de port dans le champ Add Record, 
sélectionnez la direction (From, To, ou Both), puis cliquez Add Port. La nouvelle règle va être déployée. Maintenant, vous pouvez 
sélectionner l’action à prendre lorsqu’un nouveau paquet est procédé: le paquet peut être ou bien capturé, ou bien ignoré. Vous 
pouvez aussi cliquer sur le bouton Port Reference pour obtenir une liste de tous les ports connus; double-cliquez sur le port que 
vous souhaitez ajouter et son nombre apparaîtra dans la boîte d’entrée. Les ports peuvent aussi être entrés en texte; par exemple, 
vous pouvez taper en http ou pop3, puis le programme convertira le nom du port en valeur numérique. 
 

 
 
Cet exemple démontre comment faire pour que le programme ignore les paquets qui viennent du port 80 et vont et viennent du 
port 137. Cette règle préviendra CommView de déployer le trafic entrant HTTP, aussi bien que le trafic de noms de service entrant 
et sortant NetBIOS. Tous les paquets venant et allant de ports différents vont être capturés.  
 
 



 

 

TCP Flags 
 
Vous permet d’ignorer ou de capturer des paquets basés sur les flags TCP. Cochez un flag ou une combinaison de flags dans le 
champ Add Record, puis cliquez Add Flags. La nouvelle règle va être déployée. Maintenant, vous pouvez sélectionner l’action à 
prendre lorsqu’un nouveau paquet entrant avec flags TCP est procédé: le paquet peut être capturé ou ignoré. 
 

 
 
Cet exemple démontre comment faire pour que le programme ignore les paquets TCP avec le flag PSH ACK. Tous les paquets avec 
des flags TCP différents vont être capturés. 
 
 



 

 

Text 
 
Vous permet de capturer des paquets contenant un certain texte. Entrez une chaîne de texte dans le champ Add Record, 
sélectionnez le type de l’information entrée (As String ou As Hex), puis cliquez Add Text. La nouvelle règle va être déployée. 
Vous pouvez entrer une chaîne soit en texte, soit en valeur hexadécimale. La dernière méthode devrait être utilisée lorsque vous 
voulez entrer des caractères imprononçables: tapez seulement des valeurs à caractères hexadécimaux, séparées par des espaces, 
tel que montré ci-dessous. Maintenant, vous pouvez sélectionner l’action à prendre lorsqu’un nouveau paquet est procédé: le 
paquet peut être capturé ou ignoré. 
 

 
 
Cet exemple démontre comment faire pour que le programme capture seulement les paquets contenant  "GET" ou des données 
hexadécimales 01 02 03 04. Cochez la case Case sensitive, si vous désirez que les règles soient sensibles à la casse. Tous les 
autres paquets ne contenant pas le texte ci-dessus mentionné vont être ignorés. 
 
Avancées 
 
Les règles avancées sont les règles les plus puissantes et les plus flexibles qui vous permettent de créer des filtres complexes en 
utilisant la logique Boolean. Pour une aide détaillée sur l’utilisation des règles avancées, veuillez s’il-vous-plaît consulter le chapitre 
Advanced Rules . 
 
 



 

 

 
Advanced Rules 
 
Les règles avancées sont les règles les plus puissantes et les plus flexibles qui vous permettent de créer des filtres complexes en 
utilisant la logique Boolean. L’utilisation des règles avancées requiert une compréhension de base des mathématiques et de la 
logique, mais la synthaxe des règles est tout de même facile à comprendre. 
 

 
 
Survol 
 
Pour ajouter une nouvelle règle, vous devriez entrer un nom arbitraire dans le champ Name, sélectionner l’action 
(Capture/Ignore), entrer une Formule en utilisant la synthaxe décrite ci-dessous, puis cliquer Add/Edit. Votre nouvelle règle 
sera ajoutée à la liste et deviendra active immédiatement. Vous pouvez ajouter autant de règles que vous le désirez, mais 
seulement les règles dont la case à côté de son nom est cochée seront actuellement actives. Vous pouvez activer/désactiver les 
règles en cochant/décochant les cases correspondantes ou en supprimant complètement les règles en utilisant le bouton Delete. Si 
plus d’une règle est active, vous pouvez évaluer le résultat de celles-ci combinées en cliquant le bouton Evaluate. Veuillez noter 
que l’activation de règles multiples sont combinées en utilisant l’opérateur logique OR, par exemple si vous avez trois règles actives,  
RÈGLE1, RÈGLE2, et RÈGLE3, la règle résultant est RÈGLE1 OR RÈGLE2 OR RÈGLE3. 
 
Vous pouvez utiliser les règles avancées en conjonction avec les règles de base décrites dans le chapitre précédent, mais si vous 
vous sentez confortable avec la logique Boolean, c’est une bonne idée d’utiliser seulement les règles avancées, puisqu’elles offrent 
beaucoup plus de flexibilité. Les règles de base sont combinées avec les règles avancées en utilisant l’opérateur logique AND. 
 
Description de la Synthaxe 
 
dir – Direction des paquets. Les valeurs possibles sont in (internes), out (externes et pass-through (passant à travers). 
 
etherproto – Protocole Ethernet, les 13ème et 14ème bytes d’un paquet. Les valeurs acceptables sont des nombres (par exemple 
etherproto=0x0800 pour IP) ou des alias communs (par exemple etherproto=ARP, lequel est équivalent à 0x0806).  
 
ipproto – Protocole IP. Les valeurs acceptables sont des nombres (par exemple ipproto!=0x06 pour TCP) ou les alias 
communément utilisés (par exemple ipproto=UDP, lequel est équivalent à 0x11). 
 
smac – Adresses MAC source. Les valeurs acceptables sont des adresses MAC à notation hexadécimale (par exemple 
smac=00:00:21:0A:13:0F) ou des alias définis par l’utilisateur. 
 
dmac – Adresses MAC de destination.  
 
sip – Adresses IP source. Les valeurs acceptables sont des adresses IP à notation avec points (par exemple sip=192.168.0.1), des 
adresses IP avec des jokers (wildcards) (par exemple sip!=*.*.*.255),  des adresses réseau avec masques subnet (par exemple 
sip=192.168.0.4/255.255.255.240 ou sip=192.168.0.5/28), des étendues d’adresses IP (par exemple sip from 192.168.0.15 to 
192.168.0.18 ou sip in 192.168.0.15 .. 192.168.0.18  ) ou des alias définis par l’utilisateur. 
 
dip -  Adresses IP de destination. 
 
sport – Port source pour les paquets TCP et UDP. Les valeurs acceptables sont des nombres (par exemple sport=80 for HTTP), des 
étendues (par exemple sport from 20 to 50  ou sport in 20..50 pour tout numéro de port compris entre 20 et 50) ou des alias 
définis par le système d’exploitation (par exemple sport=ftp, lequel est équivalent à 21). Pour la liste des alias supportés par votre 
système d’exploitation, cliquez View => Port Reference. 
 



 

 

dport – Port de destination pour les paquets TCP et UDP.  
 
flag – Flag TCP.  Les valeurs acceptables sont des nombres (par exemple 0x18 pour PSH ACK) ou un ou plusieurs des caractères 
suivants:  F (FIN), S (SYN), R (RST), P (PSH), A (ACK), et U (URG), ou le mot-clé has, lequel veut dire que le flag contient une 
certaine valeur. Exemples d’utilisation: flag=0x18, flag=SA, flag has F. 
 
size – Taille des paquets. Les valeurs acceptables sont des nombres (par exemple size=1514) ou des étendues (par exemple size 
from 64 to 84 ou size in 64..84 pour toute taille comprise entre 64 et 84). 
 
str – Contenu des paquets. Utilisez cette fonction pour indiquer que le paquet doit contenir une certaine chaîne. Cette fonction 
comporte trois arguments: string, position, et case-sensitivity. Le premier argument est une chaîne, par exemple 'GET'. Le 
deuxième argument est un nombre qui indique la position de la chaîne (offset) dans le paquet. La valeur offset est de base zéro, 
c’est-à-dire que si vous recherchez le premier byte du paquet, la valeur offset doit être 0. Si la valeur offset n’est pas importante, 
utilisez –1. Le troisième argument indique la sensibilité à la casse et peut être soit false (insensible à la casse) ou true (sensible à la 
casse). Les deuxième et troisième arguments sont optionnels; si omis, la valeur offset est de –1 par défaut et la sensibilité à la 
casse est false par défaut. Exemples d’utilisation: str('GET',-1,false), str('GET',-1), str ('GET'). 
 
hex – Contenu des paquets. Utilisez cette fonction pour indiquer que le paquet doit contenir un certain modèle hexadécimal de 
byte. Cette fonction possède deux arguments: hex pattern et position. Le premier argument est une valeur hexadécimale, par 
exemple 0x4500. Le deuxième argument est un nombre qui indique la position du modèle (offset) dans le paquet. La valeur offset 
est de base zéro, c’est-à-dire que si vous recherchez le premier byte du paquet, la valeur offset doit être 0. Si la valeur offset n’est 
pas importante, utilisez –1. Le deuxième argument est optionnel; si omis, la valeur offset est de –1 par défaut. Exemples 
d’utilisation:  hex(0x04500, 14) , hex(0x4500, 0x0E), hex (0x010101). 
 
Les mots-clés décrits ci-dessous peuvent être utilisés avec les opérateurs suivants: 
 
and – Conjonction Boolean. 
or  - Disjonction Boolean.   
not – Négation Boolean.  
=  - Équation arithmétique.  
!= - Inéquation arithmétique. 
<> - Inéquation arithmétique. 
> - Plus grand que - Arithmétique. 
< - Moins grand que - Arithmétique. 
( ) – Parenthèses, Opérateur de contrôle pour les règles prioritaires. 
 
Tous les nombres peuvent être à notation décimale ou hexadécimale. Si vous voulez utiliser la notation hexadécimale, le nombre 
doit être précédé par 0x, c’est-à-dire que vous pouvez utiliser soit 15  ou 0x0F.  
 
Exemples 
 
Vous trouverez ci-dessous un certain nombre d’exemples illustrant la synthaxe des règles. Chaque règle est suivie par nos 
commentaires sur la fonction de chacune d’elles. Les règles sont montrées en rouge. Les commentaires sont séparés des règles par 
deux barres obliques. 
 

• dir!=pass // Capture seulement les paquets entrants et sortants. Les paquets passant à travers d’autres stations de travail 

sur le LAN sont ignorés. 

• (smac=00:00:21:0A:13:0E or smac=00:00:21:0A:13:0F) and etherproto=arp // Capture les paquets ARP envoyés par 

deux ordinateurs, 00:00:21:0A:13:0E et 00:00:21:0A:13:0F. 

• ipproto=udp and dport=137 // Capture les paquets UDP/IP envoyés au numéro de port 137. 

• dport=25 and str('RCPT TO:', -1, true) // Capture les paquets TCP/IP ou UDP/IP qui contiennent "'RCPT TO:" et dont le 

port de destination est 25. 

• not (sport>110) // Capture tout, excepté les paquets dont le port source est plus grand que 110 

• (sip=192.168.0.3 and dip=192.168.0.15)  or (sip=192.168.0.15 and dip=192.168.0.3) // Capture seulement les paquets 

IP envoyés entre deux machines, 192.168.0.3 et 192.168.0.15. Tous les autres paquets sont discartés. 

• ((sip from 192.168.0.3 to 192.168.0.7) and (dip = 192.168.1.0/28)) and (flag=PA) and (size in 200..600) // Capture les 

paquets TCP dont la taille est comprise entre 200 et 600 bytes et venant des adresses IP comprises entre 192.168.0.3 - 

192.168.0.7, dont l’adresse IP de destination est dans le segment 192.168.1.0/255.255.255.240, et où le flag TCP est 

PSH ACK. 

• Hex(0x0203, 89) and (dir<>in) // Capture les paquets qui contiennent 0x0203 à la valeur offset 89, où la direction des 

paquets n’est pas entrante. 

 



 

 

 

Reconstruction de Sessions TCP 
 
Cet outil vous permet de visionner la conversation TCP entre deux hôtes.  Pour reconstruire une session TCP, vous devriez 
premièrement sélectionner un paquet TCP à partir de l’onglet Packets. Si vous voulez reconstruire entièrement la session, il est 
recommandé de sélectionner le premier paquet dans la session; autrement, la reconstruction pourrait commencer au milieu de la 
"conversation". Après, localisez et sélectionnez le paquet, cliquez dessus avec le bouton droit de la souris et sélectionnez 
Reconstruct TCP Session à partir du menu contextuel (pop-up), tel que montré ci-dessous: 
 

 
 
La reconstruction de sessions opère mieux pour les protocoles à base textuelle, tels que POP3, Telnet, ou HTTP. Bien sûr, vous 
pouvez aussi reconstruire le téléchargement d’un large document compressé, mais CommView peut alors prendre un long moment 
à reconstruire plusieurs megabytes de données, et l’information obtenue serait inutile dans la plupart des cas. Une simple session 
HTTP en modes ASCII et HTML est montrée ci-dessous: 
  

 
 



 

 

 
 
 
Vous pouvez filtrer vers l’extérieur les données qui sont venues de l’une des directions, en décochant une des cases à cocher dans 
le volet inférieur. Les données entrantes et sortantes sont marquées par différentes couleurs pour votre convenance. Si vous 
désirez modifier l’une de ces couleurs, cliquez Settings =>Colors, et choisissez une couleur différente. Vous pouvez activer ou 
désactiver le word wrapping en utilisant l’item Word Wrap dans le menu Settings.  
 
Le menu déroulant Display type vous permet de visualiser les données dans les formats ASCII (données texte nature), HEX 
(données hexadécimales), HTML (pages web) et EBCDIC (données d’encodage d’ordinateurs centraux IBM). Veuillez prendre note 
que visualiser ces données en format HTML ne reproduit pas nécessairement exactement le même résultat que celui que vous 
pouvez voir dans le navigateur Web (par exemple, vous ne serez pas capable de voir les graphiques incorporés); toutefois, le 
résultat devrait vous donner une petite idée de l’apparence de la page originale. 
 
Les boutons Navigation vous permettent de rechercher le tampon pour la session TCP précédente ou suivante entre deux hôtes. 
Si vous avez de multiples sessions dans le tampon entre deux hôtes, et que vous désirez les voir une à la fois, il est recommandé de 
commencer la reconstruction à partir de la première session, puisque le bouton back (« précédent » - <<) ne peut pas naviguer 
au-delà de la session qui a été reconstruite en premier. 
 
Les données obtenues peuvent être sauvegardées en format binaire, texte, ou RTF (rich text file) en cliquant File =>Save As… . 
 



 

 

 
Statistiques et Rapports 
 
Cette fenêtre (View => Statistics) déploie les statistiques vitales de réseau de votre ordinateur ou segment LAN, telles que le 
taux de paquets par seconde, le taux de bytes par seconde, et les graphiques de distribution de protocoles et sous-protocoles IP. 
Vous pouvez copier n’importe lequel de ces graphiques au presse-papiers en double-cliquant sur un graphique. Les graphiques 
circulaires de protocoles et sous-protocoles IP peuvent exécuter une rotation en utilisant les petits boutons au coin bas droit pour 
une meilleure visibilité des tranches des graphiques.  
 
Les données déployées sur chaque onglet peuvent être sauvées en format bitmap ou en texte délimité par des points-virgules en 
utilisant le menu contextuel (pop-up) ou glisser-déposer. L’onglet Report permet que CommView génère automatiquement des 
rapports coventionnels en HTML ou en format texte délimité par des points-virgules. 
 
Les statistiques de réseau peuvent être collectionnées en utilisant toutes les données qui passent au travers de votre adaptateur de 
réseau ou en utilisant les règles qui sont actuellement configurées. Si vous voulez que les compteurs de statistiques procèdent 
seulement les données (paquets) qui correspondent aux règles configurées et ignorent toutes les autres données, vous devriez 
cocher la case Apply current rules. 
 
General   
Affiche des histogrammes de Paquets par seconde et d’Octets par seconde, un graphique de l’utilisation de la bande passante (le 
trafic par seconde divisé par la vitesse de liaison du modem ou du NIC), ainsi que tous les compteurs de paquets et d’octets. 
 
IP Protocols 
Déploie la distribution des principaux protocoles IP: TCP, UDP, et ICMP. Utilisez la liste déroulante Chart by pour sélectionner une 
des deux méthodes de calcul disponibles: par nombre de paquets ou par nombre d’octets. 
 
IP Sub-protocols 
Déploie la distribution des principales applications de niveau de sous-protocoles IP: HTTP, FTP, POP3, SMTP, Telnet, NNTP, 
NetBIOS, HTTPS, et DNS. Pour ajouter plus de protocoles, cliquez sur le bouton Customize. Ce dialogue vous permet de définir 
jusqu’à 4 protocoles conventionnels. Vous devriez entrer un nom de protocole, sélectionner le type de protocole (TCP/UDP), puis le 
nombre du port. Utilisez la liste déroulante Chart by pour sélectionner une des deux méthodes de calcul disponibles: par nombre 
de paquets ou par nombre d’octets.   
 
Sizes 
Déploie le graphique de distribution de la taille d’un paquet. 
 
LAN Hosts (MAC) 
Liste les hôtes LAN par adresses MAC et déploie les statistiques de transfert de données. Vous pouvez assigner des alias aux 
adresses MAC. 
 
LAN Hosts (IP) 
Liste les hôtes LAN actifs par adresses IP et déploie les statistiques de transfert de données. Puisque les paquets IP capturés par le 
programme peuvent originer d’un nombre illimité d’adresses IP (à la fois de votre LAN interne et externe), par défaut cet onglet ne 
déploie aucune statistique. Pour avoir les statistiques déployées, vous devriez d’abord configurer l’étendue d’adresses IP à être 
contrôlées en cliquant Add/Set Ranges. Normalement, ces étendues devraient appartenir à votre LAN, et configurer le 
programme pour contrôler une certain étendue d’adresses IP permet l’utilisation des statistiques. Vous pouvez entrer n’importe quel 
nombre d’étendues, mais le nombre total d’adresses IP à être contrôlées ne peut excéder 1,000. Pour supprimer une étendue, 
cliquez le bouton droit de la souris sur la liste des étendues et sélectionnez la commande de menu appropriée. Vous pouvez 
assigner des alias aux adresses IP. 
 
Errors 
Déploie l’information sur les erreurs Ethernet obtenues directement de l’adaptateur. Ci-dessous sont  
Rx CRS Errors 
Le nombre de cadres reçus avec erreur circular redundancy check (CRC-vérification circulaire de redondance) ou frame check 
sequence (FCS-vérification de séquence de cadres). 
Rx Alignment Errors 
Le nombre de cadres reçus avec erreurs d’alignements. 
Rx Overrun 
Le nombre de cadres non reçus dû à une surcharge d’erreurs sur le NIC. 
Tx One Collision 
Le nombre de cadres transmis avec succès après exactement une collision. 
Tx More Collisions 
Le nombre de cadres transmis avec succès après plus d’une collision. 
Tx Deferred 
Le nombre de cadres transmis avec succès après que le NIC diffère une transmission au moins une fois. 
Tx Max Collisions 
Le nombre de cadres non transmis dû aux collisions excessives. 
Tx Underrun 
Le nombre de cadres non transmis dû à une sous-utilisation d’erreurs sur le NIC. 
Tx Heartbeat Failure 
Le nombre de cadres transmis avec succès sans détection du Collision-Detect Heartbeat. 
Tx Times CRS Lost 
Le nombre de fois que le signal CRS a été perdu durant la transmission de paquets. 
Tx Late Collisions 



 

 

Le nombre de collisions détectées après la fenêtre normale. 
Rx Frames w/Errors 
Le nombre de cadres qu’un NIC reçoit mais qui n’indique pas les protocoles dû aux erreurs. 
Rx Frames w/o Errors 
Le nombre de cadres qu’un NIC reçoit sans erreur et indique les protocoles reliés. 
Tx Frames w/Errors 
Le nombre de cadres qu’un NIC échoit à transmettre. 
Tx Frames w/o Errors 
Le nombre de cadres qui sont transmis sans erreur. 
 
Veuillez s’il-vous-plaît noter que: 

• Les connexions par modem RTC ne sont pas supportées, seulement le matériel de cartes Ethernet. 
• Votre adaptateur peut ne pas supporter tous les champs listés. Quelques marchands fabriquent des NICs qui procurent 

toute l’information requise, d’autres pas. 
• Contrairement à d’autres données dans la fenêtre Statistics, les données sur l’onglet Errors ne peuvent pas être 

réinitialisées lorsque vous cliquez sur le bouton Reset. Le compteur est initialisé lorsque votre ordinateur démarre. 
• Cet onglet n’est pas supporté sous Windows 95. 

 
 
Report 
Cet onglet vous permet que CommView génère automatiquement des rapports conventionnels en HTML ou en format texte délimité 
par des points-virgules. 
 



 

 

 

Utilisation d’alias 
 
Les alias sont des noms faciles à mémorer et humainement lisibles que CommView substituera pour une adresse MAC ou IP, 
lorsque sont montrés les paquets sur les onglets Packets et Statistics. Ceci peut rendre les paquets plus facilement reconnaissables 
et analysables. Par exemple, 00:00:19:2D:0D:35 devient GATEWAY2, et ns1.earthlink.com devient MyDNS. 
 
Pour ajouter un alias MAC, cliquez le bouton droit de la souris sur un paquet et sélectionnez Create Alias Using Source MAC ou 
Using Destination MAC à partir du menu contextuel (pop-up). Une fenêtre va apparaître où le champ de l’adresse MAC est déjà  
rempli, et vous n’aurez qu’a y ajouter un alias. Alternativement, vous pouvez cliquer Tools =>Aliases et remplir l’adresse MAC et 
les champs Alias manuellement. Pour supprimer un alias ou effacer la liste entière des alias, cliquez le bouton droit de la souris sur 
la fenêtre Aliases et sélectionnez Delete Record ou Clear All. Ceci s’applique aussi à la creation d’alias IP. Lorsqu’un nouvel alias 
IP est créé en cliquant de la droite sur un paquet, le champ d’alias est préalablement rempli avec le nom d’hôte correspondant (si 
disponible) et peut être modifié par l’utilisateur.  
 

 
 



 

 

 
Packet Generator 
 
Cet outil vous permet d’éditer et d’envoyer des paquets via votre carte réseau. Il est disponible seulement sous Windows NT, 
Windows 2000, et Windows XP. Pour ouvrir le Packet Generator, cliquez View => Packet Generator, ou sélectionnez un paquet 
de l’onglet Packets, cliquez le bouton droit de la souris sur ce dernier, puis sélectionnez la commande Send Packet. 
 

 
 
Le Packet Generator vous permet de changer le contenu du paquet et d’avoir le décodage du paquet déployé dans la fenêtre de 
gauche, lorsque vous l’éditez. Pour les paquets IP, TCP, UDP et ICMP, vous pouvez automatiquement corriger le(s) sommes de 
contrôle (checksums(s)) en cliquant sur le bouton sigma. 
 
Une fois que vous avez édité un paquet, utilisez les contrôles ci-dessous pour l’envoyer: 
 
Packet Size – modifie la taille d’un paquet. 
Packets Per Second – contrôle la vitesse à laquelle les paquets seront envoyés. Soyez certain de ne pas envoyer de paquets trop 
rapidement si vous avez une connexion lente. Par exemple, envoyer un paquet de 1,000 bytes 5,000 fois par seconde est plus que 
ce que votre ordinateur 10Mbit NIC peut supporter. 
Continuously – sélectionnez cette option si vous désirez que le Packet Generator envoie des paquets continuellement jusqu’à ce 
que vous cliquiez sur Stop. 
Time(s) – sélectionnez cette option si vous désirez que le Packet Generator envoie un paquet un nombre donné de fois. 
Send/Stop – cliquez ce bouton lorsque vous êtes prêt(e) à envoyer des paquets ou lorsque vous désirez arrêter d’en envoyer. 
 
Travailler avec plusieurs paquets 
 
Vous pouvez utiliser le Packet Generator pour envoyer plusieurs paquets à la fois. Pour ce faire, sélectionnez seulement les paquets 
que vous voulez envoyer dans la liste et invoquez le the Packet Generator en utilisant le bouton droit de la souris qui déploie un 
menu contextuel (pop-up). Alternativement, vous pouvez glisser-et-déposer des fichiers capturés dans tous les formats supportés 
directement dans la fenêtre du Packet Generator. Lorsque plusieurs paquets sont envoyés, l’éditeur de paquets (packer editor) et le 
décodeur d’arborescence (decoder tree) deviennent invisibles. 
 
Sauvegarder des paquets édités 
 
Si vous éditez un paquet et que vous voulez le sauvegarder, simplement glisser le décodeur d’arborescence (decoder tree) sur le 
bureau ou dans tout autre dossier, puis un nouveau fichier en format CCF contenant le paquet sera créé. Le nom du fichier est 
toujours PACKET.CCF. 
 
 
ATTENTION:  
 

1. N’utilisez pas le Packet Generator, à moins que vous ne sachiez exactement quel effet vous désirez rencontrer. Envoyer 
des paquets peut produire des résultats imprévisibles, et nous recommandons fortement l’abstention de l’utilisation de cet 
outil, à moins que vous ne soyiez un administrateur de réseau expérimenté. 

2. Il devrait y avoir au moins un ordinateur opérant sur votre LAN, en plus de votre propre ordinateur, lorsque vous utilisez 
cet outil. Autrement, vous expérimenterez des délais sévères dans l’envoi de paquets. 

3. Cet outil ne peut être utilisé pour envoyer des paquets via les adaptateurs RAS sous Windows NT. 
 



 

 

 

NIC Vendor Identifier 
 
Les premières 24 bits d’une adresse MAC de votre carte réseau identifie uniquement le marchand de la carte réseau. Ce nombre de 
24-bits est appelé le OUI ("Organizationally Unique Identifier").  Le NIC Vendor Identifier est un outil qui vous permet de rechercher 
un nom de marchand par adresse MAC. Pour rechercher un nom de marchand, cliquez Tools =>NIC Vendor Identifier, entrez 
une adresse MAC, puis cliquez Find. Le nom du marchand sera alors déployé.   
 

 
 
La liste des marchands est contenue dans le fichier MACS.TXT, situé dans le dossier d’application de CommView. Vous pouvez 
éditer cette liste manuellement pour ajouter/modifier de l’information. 
 



 

 

 
Utilisation de Remote Agent 
 
CommView Remote Agent est un produit compagnon qui peut être utilisé pour contrôler le trafic de réseau à distance. Tout ce 
que vous avez à faire est d’installer Remote Agent sur l’ordinateur ciblé, et ensite utiliser CommView pour vous connecter à Remote 
Agent. Une fois que vous êtes connecté et authentifié, vous pouvez commencer à contrôler à distance comme si vous y étiez. 
 
Important: le chapitre décrit comment utiliser CommView pour se connecter à Remote Agent et capturer le trafic à distance. Pour 
une information détaillée sur l’installation et la configuration de Remote Agent, veuillez s’il-vous-plaît vous reférer au fichier d’aide 
inclus avec Remote Agent. Il est hautement recommandé que vous lisiez minutieusement la documentation de Remote Agent avant 
d’en faire l’utilisation. CommView Remote Agent peut être téléchargé de notre site. 
 
Pour passer au mode de contrôle à distance, cliquez File => Remote Monitoring Mode. Une barre d’outils additionnelle 
apparaîtra dans la fenêtre principale de CommView en-dessous de la barre d’outils principale. Entrez l’adresse IP de l’ordinateur 
opérant CommView Remote Agent dans la section d’entrée de données d’adresse IP et cliquez Connect. Si vous êtes derrière un 
pare-feu ou un serveur mandataires (proxy), ou utilisez un port non-standard de Remote Agent, vous pouvez avoir besoin de 
cliquer sur le bouton Network Settings pour changer le nombre du port et/ou entrer les configurations de serveur mandataire 
(proxy) SOCKS5. 
 

 
 
Une fenêtre apparaîtra et le mot de passe vous sera demandé. Entrez le mot de passe de Remote Agent, et si le mot de passe est 
correct, une connexion sera établie. Vous verrez alors le message Link Ready, puis la boîte de selection d’adaptateur listera les 
adaptateurs d’ordinateur à distance. 
 

 
 
Maintenant est le meilleur moment de configurer les règles de capture en utilisant l’onglet Rules. Il est très important de configurer 
ces règles correctement pour que le volume du trafic entre Remote Agent et CommView n’excède pas la limite de la bande passante 
(bandwidth) sur l’une ou l’autre des connexions, ou vous allez expérimenter un délai remarquable. Soyez sûr(e) de filtrer vers 
l’extérieur les paquets inutiles (voyez plus sur ce sujet ci-dessous). Lorsque vous êtes prêts à commencer à contrôler, sélectionnez 
l’adaptateur de réseau à partir de la liste et cliquez le bouton Start Capture dans la barre d’outils.  
 

 
 
CommView commencera à capturer le trafic d’ordinateur à distance comme si c’était le trafic de votre réseau local; il n’y a 
virtuellement aucune différence entre l’utilisation de CommView localement ou à distance. Lorsque vous en avez terminé avec le 
contrôle à distance, simplement cliquez sur le bouton Stop Capture de la barre d’outils. Vous pouvez alors modifier l’adaptateur et 
vous déconnecter de Remote Agent en cliquant sur le bouton Disconnect de la barre d’outils. Pour retourner au mode standard, 
cliquez File => Remote Monitoring Mode, puis la barre d’outils additionnelle disparaîtra. 

http://www.tamos.com/download/main/


 

 

 



 

 

 
Configurer les Options 
 
Vous pouvez configurer quelques-unes des options du programme en sélectionnant Settings dans le menu. 
 
 
Fonts 
 
Utilisez cet item du menu pour modifier la fonte du texte de l’interface et des paquets. Pour changer la couleur du texte des 
paquets, utilisez le menu Options (ci-dessous). 
 
 
Options 
 
General 
 
Auto-start capturing – cochez cette case si vous désirez que CommView commence à capturer les paquets immédiatement après 
le lancement du programme. Pour les systèmes avec de multiples adaptateurs, vous devriez aussi sélectionner l’adaptateur qui doit 
être utilisé à partir de la liste déroulante. 
 
Network 
 

Disable DNS resolving  – cochez cette case si vous ne voulez pas que CommView performe reverse DNS lookups des 
adresses IP. Si vous la cochez, la colonne Hostname sur l’onglet IP Statistics sera vide. 

 
Convert numeric port values to service names  – cochez cette case si vous voulez que  CommView déploie les noms 
de service au lieu des nombres. Par exemple, si cette case est cochée, port 21 est montré comme ftp, et port 23 comme 
telnet. Le programme convertit les valeurs numériques en noms de services en utilisant le dossier SERVICES installé par 
Windows. Dépendemment de la version de votre Windows, le dossier SERVICES est localisé dans différents fichiers: avec 
Windows 95/98/Me vous pouvez le trouver dans le fichier \Windows, et avec Windows NT/2000/XP, vous le trouvez dans le 
fichier \Winnt\system32\drivers\etc. Vous pouvez éditer ce fichier manuellement si vous désirez ajouter plus de ports/noms 
de services. 
 
Convert MAC addresses to aliases – substitue les adresses MAC pour des alias sur l’onglet Packets. Les Alias peuvent 
être assignés aux adresses MAC en utilisant la commande de menu Settings =>MAC Aliases. 
 
Convert IP addresses to aliases – substitue les adresses IP pour des alias sur les onglets Packets et Statistics. Les 
Alias peuvent être assignés aux adresses IP en utilisant la commande de menu Settings =>IP Aliases. 
 
Use non-promiscuous mode – par défaut, CommView place l’adaptateur de réseau en mode furtif, ce qui veut dire que 
le programme capture tout le trafic du segment local du LAN. Cocher cette case fait basculer le mode de CommView à non-
furtif, lequel vous utilisez quelques fois, par exemple si la politique IT de votre compagnie ne vous permet pas le contrôle 
furtif de paquets, ou alors lorsque vous désirez réduire l’utilisation du CPU dans une situation où vous êtes seulement 
interessé dans vos propres paquets entrants et sortants et devez filtrer à l’extérieur de multiples paquets passants.  
 
 

Memory Usage 
 
Display  
 

Maximum packets in buffer  – configure le nombre maximum de paquets que le programme stocke dans la mémoire et 
peut déployer dans la Packet List (2ème onglet). Par exemple, si vous configurez cette valeur à 3000, seulement les 3000 
derniers paquets seront stockés dans la mémoire et la Packet List. Le plus haut cette valeur atteint, le plus de ressources 
informatiques le programme consomme. 

 
Notez que si vous souhaitez avoir accès à un nombre élevé de paquets, il est recommandé que vous utilisiez les 
caractéristiques auto-sauvergarde (auto-saving) (consultez Logging pour plus d’informations): cette caractéristique vous 
permet de supprimer tous les paquets d’un fichier log sur un disque dur. 
 
Maximum IP statistics lines  - configure le nombre de lignes que le programme déploie sur l’onglet  IP Statistics. 
Lorsque le nombre de connexions excède la limite, les connexions qui ont été inoccupées pour la plus longue période de 
temps sont supprimées de la liste. 

 
Driver Buffer (Windows NT/2000/XP only) – configure la taille du pilote de la mémoire tampon. Cette caractéristique affecte 
la performance du programme: le plus de mémoire est allouée pour le pilote de la mémoire tampon, le moins de paquets le 
programme échappe. Pour un trafic bas de LANs et de connexions par modem RTC, la taille de la mémoire tampon n’est pas 
critique. Pour les trafic élevés de LANs, vous pourriez vouloir augmenter la taille du mémoire tampon si le programme échappe des 
paquets. Pour verifier le nombre de paquets échappés, utilisez la commande de menu File => Performance Data lorsque la 
capture est en cours. 
 
IP Statistics 
 



 

 

Display Logic – vous permet de sélectionner la mise en page des IP Statistics qui convient le mieux à vos besoins. Sélectionner un 
item à partir de la liste déroulante va déployer la description logique de celui-ci. Dans la plupart des cas, il est recommandé 
d’utiliser la logique Smart par défaut. 
 
Define Local IP Addresses – vous devriez utiliser cet outil si vous contrôlez un trafic LAN avec plusieurs paquets passant à 
travers et une mixture d’adresses IP internes et externes. Dans une telle situation, CommView ne "connaît" pas quelles adresses IP 
devraient être traitées localement et lesquelles pourraient renverser l’adresse IP dans les colonnes Local et Remote IP. Cet outil 
vous permet de définir les adresses de réseau locales et les masques subnet pour assurer que la fenêtre IP Statistics fonctionne 
correctement. Ceci fonctionnera seulement si vous utilisez la logique Smart par défaut.  
 
Colors 
 
Packet color – configure la couleur pour déployer les paquets sur l’onglet Packets basée sur la direction du paquet (entrant, 
sortant, passant à travers). Pour modifier la couleur, sélectionnez la direction du paquet à partir de la liste déroulante et cliquez sur 
le rectangle coloré. 
 
Colorize Packet Headers – cochez cette case si vous désirez que CommView colore le contenu des paquets. Si cette case est 
cochée, le programme déploie les quatre premières couches de paquets en utilisant différentes couleurs.  Pour modifier la couleur, 
sélectionnez le type d’entête pour laquelle vous désirez changer la couleur et cliquez sur le rectangle coloré. 
 
Formula syntax highlighting – personnalisez les couleurs pour la surbrillance de mots-clé de formules dans la fenêtre de 
syntaxe avancée Advanced Rules. 
 
 
Decoding 
 
Always fully expand all nodes in the decoder window – cochez cette case si vous aimeriez avoir tous les noeuds dans la 
fenêtre decoder automatiquement étendus, lorsque vous sélectionnez un nouveau paquet dans la Packet List. 
 
Decode up to the first level only in ASCII export – cette option affecte le format de décodage utilisé lorsque vous exportez un 
paquet log ou un paquet individuel en dossier ASCII avec décodage. Si cette case est cochée, seulement les nœuds de tête vont 
être sauvegardés. Par exemple, si vous sauvegardez un paquet TCP/IP lorsque cette option est désactivée, tout Type of service 
sous-noeud sont sauvegardés. Lorsque cette option est activée, ces sous-noeuds ne sont pas sauvegardés. Cocher cette case fait 
des fichiers ASCII sortants moins détaillés et plus compacts. 
 
Ignore incorrect checksums when reconstructing TCP sessions – cette option affecte la façon dont CommView traîte les 
paquets TCP/IP malformés lors de reconstructions de sessions TCP. Par défaut, cette option est activée, et les paquets avec des 
sommes de contrôle (checksums) incorrectes sont discartés dans le processus de reconstruction. Si vous désactivez cette option, les 
paquets avec des sommes de contrôle (checksums) incorrectes seront discartés et non déployés dans la fenêtre de reconstruction 
de sessions TCP. Attention aux utilisateurs de carte Gigabit: tous les paquets sortants auront une somme de contrôle (checksum) 
incorrecte si la caractéristique "checksum offload" est présente. Si vous désactivez cette option, il est probable que vous verrez 
seulement la moitié de la session TCP reconstruite. 
 
Miscellaneous 
 
Hide from the taskbar on minimization  - cochez cette case si vous ne voulez pas voir le bouton de programme sur la barre 
d’outils de Windows lorsque vous minimisez le programme. Si cette case est cochée, utilisez l’icône de plateau du programme pour 
sa restitution après sa minimisation. 
 
Allow multiple application instances – cochez cette case si vous voulez avoir plusieurs instances de CommView opérant 
simultanément, pour être capable de capturer le trafic passant à travers différents adaptateurs. Cette option n’est pas disponible 
sous Windows 95. 
 
Prompt for confirmation when exiting the application – cochez cette case si vous désirez que le programme vous demande 
une confirmation lorsque vous le fermez.  
 
Auto-scroll packet data window  - si cette case est cochée, le programme examine le texte de la fenêtre de données de paquet 
automatiquement lorsque vous sélectionnez un nouveau paquet de la Packet List (mais seulement si le texte ne correspond pas à 
celui dans la fenêtre). Ceci est utile lorsque vous voulez voir le contenu d’un long paquet sans examiner manuellement la fenêtre. 
 
Auto-sort new records in IP statistics  - si cette case est cochée, le programme trie automatiquement les nouveaux 
enregistrements sur l’onglet IP Statistics basé sur les critères de tri définis par l’utilisateur  (e.g. ordre ascendant des adresses à 
distance IP).  
 
Smart CPU utilization control – si cette case est cochée, le programme essaie de diminuer l’utilisation du CPU lors de la capture 
d’un taux élevé de trafic en diminuant la qualité et la fréquence des rafraîchissements d’écran. 
 
Run on Windows startup – si cette case est cochée, le programme est automatiquement lancé chaque fois que vous lancez 
Windows. 
 
Run minimized – si cette case est cochée, le programme est lancé minimisé et la fenêtre principale n’est pas déployée jusqu’à ce 
que vous cliquiez sur l’icône de plateau ou le bouton de la barre d’outils. 
 



 

 

 
Find Packet 
 
Ce dialogue (Search => Find Packet) vous permet de trouver les paquets correspondant à un texte spécifique. Entrez une chaîne 
de recherche, sélectionnez le type d’information entrée  (String ou Hex), puis cliquez Find Next. Le programme recherchera les 
paquets qui correspondent aux critères de recherches et les déploiera dans l’onglet Packets.  
 
Vous pouvez entrer une chaîne de texte, en valeur hexadécimale ou en adresse IP. Une chaîne hexadécimale devrait être utilisée 
lorsque vous voulez entrer des caractères non-prononçables: tapez seulement les valeurs de caractères hexadécimaux séparées par 
des espaces, e.g. AD 0A 02 78 04. 
 
Cochez Match Case pour une recherche sensible à la casse. Cochez At offset pour rechercher une chaîne qui commence à un 
certain décalage. Notez que l’indicateur décalage est hexadécimal et à base zéro (i.e. si vous recherchez le premier byte du paquet, 
la valeur décalage sera de 0). 
 



 

 

 
Port Reference 
 
Cette fenêtre déploie une table des nombre de ports et des noms de service correspondants. Cette référence est obtenue à partir 
du fichier SERVICES installé par Windows. Dépendemment de la version de Windows, le fichier SERVICES est localisé dans 
différents dossiers: Dans Windows 95/98/Me, vous pouvez le trouver dans le dossier \Windows, puis dans Windows NT/2000/XP, 
vous le trouvez dans le dossier \Winnt\system32\drivers\etc. Vous pouvez éditer ce fichier manuellement, si vous désirez 
ajouter plus de ports/noms de service. CommView lit ce fichier au démarrage, les changements apportés au fichier seront donc 
déployés seulement après le redémarrage du programme. 
 
 



 

 

 
Tips & Troubleshooting 
 
Questions Fréquemment Posées 
 
Dans ce chapitre, vous pouvez trouver les réponses à quelques-unes des questions les plus fréquemment demandées. Le plus 
récent FAQ est toujours disponible au http://www.tamos.com/products/commview/faq.php .   
 
Q. Est-ce que CommView peut être utilisé pour capturer le trafic d’un adaptateur (RAS) par modem RTC? 

A. Oui, Windows 95/98/Me/NT/2000/XP.  
 
Q. Qu’est-ce que CommView "voit" exactement lorsqu’installé sur un ordinateur connecté sur un LAN? 

A. CommView active le mode confus de la carte-réseau et peut capturer le trafic de réseau sur le segment du LAN. En d’autres 
mots, il capture normalement et analyse les paquets adressés à tous les ordinateurs sur le segment, pas seulement à ceux où le 
programme opère. Il y a certaines limitations pour les adaptateurs sans fil Ethernet (vous pouvez contrôler seulement le trafic 
entrant/sortant) et les réseaux commutés (consultez la prochaine question de ce FAQ sur les commutateurs). 
 
Q. Je suis connecté sur un LAN à travers un commutateur, et lorsque je lance CommView, il capture seulement les 
paquets envoyés vers et venant de ma machine. Je ne peux voir le trafic sur les autres machines. Pourquoi? 
A. Contrairement aux concentrateurs, les commutateurs préviennent les sondeurs (sniffing) confus. Dans un environnement en 
réseau avec commutateur, CommView (ou tout autre analyseur de paquets) est limité à la capture de paquets radiodiffusés et 
multidiffusés, , puis pour le trafic envoyé ou reçu par l’ordinateur sur lequel CommView opère. Cependant, les plus modernes 
commutateurs (switches) supportent le "port miroir", lequel est une caractéristique qui vous permet de configurer le commutateur 
(switch) pour rediriger le trafic qui a cours sur certains ports ou tous les ports à un port de contrôle désigné sur le commutateur 
(switch). En utilisant cette caractéristique, vous serez capable de contrôler le segment entier du LAN. Veuillez s’il-vous-plaît vous 
reférer à la documentation incluse avec votre commutateur (switch) pour connaître la disponibilité de cette caractéristique, ainsi 
que les instructions de configuration. Les manufacturiers de matériel de réseau nomment cette caractéristique différemment. Ci-
dessous se trouve une courte liste de références de matériel par trois manufacturiers majeurs – Cisco, 3COM et Intel qui supportent 
le port miroir.  
 

Manufacturier Nom utilisé pour la 
caractéristique port miroir 

Modèles de commutateurs avec support du 
port miroir 
 

Cisco Port spanning Cisco Catalyst 1900 Series Switches 
Cisco Catalyst 6000 Family Switches 
 

3COM Roving analysis port (RAP) 3Com SuperStack 3 Switch 4400 
 

Intel Port mirroring Intel Express 460T 
Intel Express 480T 

 
 
Q. Est-ce que CommView peut capturer des données à partir d’un adaptateur de réseau qui n’a pas d’adresse IP? 
A. Oui. En fait, l’adaptateur de réseau n’a pas besoin d’être relié à TCP/IP ou à tout autre protocole. Dans une situation où vous  
tentez de trouver la problématique d’un réseau, il se peut qu’il soit nécessaire de brancher l’ordinateur qui opère CommView à un 
port ou àun concentrateur disponible.  Dans de tels cas, vous n’avez pas besoin de deviner l’adresse IP disponible dans le segment 
LAN, tout ce dont vous avez besoin de faire est de délier l’adaptateur de réseau du TCP/IP et de commencer à capturer. Avec 
Windows 2000/XP, ouvrez Control Panel => Network Connexions, cliquez le bouton droit de la souris sur l’icône de connexion, 
sélectionnez Properties, puis décochez les cases correspondant aux protocoles que vous ne voulez pas voir reliés au NIC. Avec 
Windows 9x Control Panel => Network, sélectionnez  TCP/IP => Your NIC item, cliquez Remove, puis redémarrez la machine. 
 
Q. J’ai lancé le programme et cliqué "Start Capture", mais aucun paquet n’est déployé. Pourquoi? 
A. Il y a deux raisons possibles: Vous avez soit sélectionné un adaptateur de réseau inutilisé, ou fait une erreur lors de la 
configuration des règles de capture. Désactivez les règles et voyez ce qui se produit. Dans tous les cas, même lorsque les règles de 
capture sont activées, la barre de statut du programme devrait déployer le nombre total de paquets, il faudrait donc verifier ceci 
avant de paniquer.  
 
Q. J’ai remarqué que les sommes de contrôle (checksums) IP/TCP/UDP des paquets entrants sont incorrectes. 
Pourquoi donc?  
A. Les nouveaux adaptateurs de réseau Gigabit ont une caractéristique appelée TCP/UDP/IP "checksum offload", laquelle permet à 
l’adaptateur de réseau de calculer les sommes de contrôle (checksums) des paquets, tout en augmentant la performance du 
système en diminuant l’utilisation du CPU. Puisque CommView intercepte les paquets avant qu’ils n’atteignent l’adaptateur de 
réseau, la somme de contrôle apparaît incorrecte. Ceci est normal et la seule chose que cela puisse affecter est la reconstruction de 
sessions TCP, et seulement si vous avez modifié l’option par défaut "Ignore incorrect checksums" (consultez Setting Options pour 
plus d’information).  
 
Q. Est-ce que CommView supporte les adaptateurs de réseau non-Ethernet, tel que TokenRing? 
A. Actuellement pas. Désolé. 
 
Q. Est-ce que CommView fonctionne sur des ordinateurs à multi-processeurs? 
A. Oui, il fonctionne.  
 
Q. Ma connexion réseau est via un modem-câble/xDSL. Est-ce que CommView sera capable de contrôler le trafic 

http://www.tamos.com/products/commview/faq.php


 

 

dessus?  
A. Si votre modem a une interface dual USB/Ethernet et que vous pouvez la connecter sur une carte Ethernet, CommView sera 
certainement capable de capturer le trafic sur celui-ci. S’il n’a qu’une interface USB, la meilleure chose à faire est de l’essayer. 
 
Q. Mon logiciel de pare-feu m’avertit que CommView "tente d’accéder à l’Internet". Je suis au courant que certains 
sites sont capables de pister les utilisateurs en collectionnant l’information envoyée par leur programme via 
Internet. Pourquoi est-ce que CommView "tente d’accéder à l’Internet"?  
A. Ce qui alerte votre pare-feu est la tentative de convertir les adresses IP en noms d’hôtes. Puisque CommView doit contacter 
votre serveur DNS pour faire une requête DNS, ceci active inévitablement l’alarme. Vous pouvez désactiver cette caractéristique  
(Settings => Options => Disable DNS resolving), mais dans ce cas, l’onglet IP Statistics ne sera plus capable de montrer les noms 
d’hôtes. Les requêtes DNS sont les seuls types de connexions que CommView peut potentiellement effectuer. Il n’y a pas d’autres 
activités cachées. Nous ne vendons pas de logiciel d’espionnage.  
 
Q. Sous Windows 2000/XP, j’y suis souvent connecté comme utilisateur sans privilèges administratifs. Est-ce que je 
dois me déconnecter, puis me reconnecter comme administrateur pour être capable d’opérer CommView? 
A. Non, vous pouvez ouvrir le fichier de CommView, cliquer avec le bouton droit de la souris sur le fichier CV.exe tout en appuyant 
sur la touche Shift, puis sélectionner "Run As" du menu contextuel (pop-up). Entrez le nom d’utilisateur et le mot de passe de 
l’administrateur dans la fenêtre contextuelle (pop-up), puis cliquez OK pour opérer le programme.  
 
Q. J’ai Windows NT, et je vois plusieurs entrées "Remote Access WAN Wrapper" dans la liste d’adaptateurs. Lequel 
dois-je sélectionner pour que CommView capture mes paquets RAS? 

A. Tout dépend de votre système. La chose la plus facile à faire est de les essayer un par un, et dans la plupart des cas, n’importe 
lequel d’entre eux va fonctionner. Avec un des adaptateurs Remote Access WAN Wrapper, vous pourriez faire face à un effet 
indésirable: CommView capture et déploie les paquets, mais les paquets ne sont pas délivrés à vos applications en réseau (par 
exemple, le délai d’attente des connexions est échu, etc.). Si vous avez ce problème, arrêtez seulement de capturer et sélectionnez 
un différent Remote Access WAN Wrapper à partir de la liste.  
 
Q. J’ai Windows 95 et une connexion par modem RTC. À toutes les fois que je clique "Stop Capture", mon modem 
échappe la connexion. Puis-je y faire quelque chose? 

A. Oui, vous devriez télécharger et installer le Winsock et les mises à jour de réseau commuté pour Windows 95 par Microsoft. Ceci 
résoudra votre problème. Veuillez prendre note que l’ordre d’installation est importante, et que vous devriez d’abord installer les 
mises à jour de Windows Socket 2, puis ensuite les mises à jour de sécurité et de performance de réseau commuté 1.4. 
 
Windows Socket 2 Update 
 
Dial Up Networking 1.4 Performance & Security Update  
 
Q. J’ai Windows 2000/XP, et lorsque je désinstalle le programme, je reçois ce message: "CommView will now 
uninstall the drivers. Click "OK" to continue. This can take between 10 and 60 seconds." Mais alors, rien n’arrive!  
A. Ceci peut se produire s’il y a des connexions actives en réseau lorsque vous désinstallez le programme. Vous devriez 
temporairement  désactiver toutes les connexions actives tel que démontré ci-dessous: 
 

 
 
Dès que la(les) connexion(s) est(sont) désactivée(s), CommView résumera le processus de désinstallation. Lorsque la désinstallation 
sera complétée, vous pourrez réactiver les connexions.  
 
Q. J’ai Windows 2000 Terminal Server, et j’ai un problème à opérer CommView via un Terminal Services client.  
A. La solution dépend de la version de CommView: 
 
Pour CommView 3.0 et plus: Vous n’avez qu’à relancer le serveur après avoir installé le programme pour être capable d’opérer 
CommView via un Terminal Services client. 

http://www.microsoft.com/Windows95/downloads/contents/WUAdminTools/S_WUNetworkingTools/W95Sockets2/Default.asp
http://www.microsoft.com/Windows95/downloads/contents/WURecommended/S_WUNetworking/dun14win95/Default.asp


 

 

  
Pour CommView 2.4 – 2.6:  Veuillez s’il-vous-plaît cliquer ici pour télécharger une mise à jour du fichier CV2K.DLL, remplacez le DLL 
original dans le fichier d’application, puis commencez et arrêtez de capturer en tant qu’utilisateur local. Lorsque vous aurez 
redémarré votre ordinateur, soyez certain que vous puissiez capturer les paquets en tant qu’utilisateur local. Ainsi, vous ne devriez 
plus avoir de problème à opérer CommView via un Terminal Services Client. 
 
La seule limitation est qu’un adaptateur peut être ouvert par un seul utilisateur en tout temps. En d’autres mots, deux utilisateurs 
(locaux ou à distance) ne peuvent capturer le trafic à partir du même adaptateur en opérant deux instances de CommView sur le 
même serveur. 
 
Q. Lorsque je contrôle ma connexion par modem RTC, je ne vois aucun paquet PPP durant l’installation de la session 
(CHAP, LCP, etc). Est-ce normal?  
A. Désolé, les paquets PPP ne peuvent être capturés que sous Windows 95/98/NT/ME, CommView ne capture pas de tels paquets 
sous Windows 2000/XP.  
 
Q. Puis-je changer les cartes PC sur mon portatif pendant que CommView opère? 
A. Non, il est plus sécuritaire de fermer CommView, ensuite changer ou brancher/débrancher votre carte, puis redémarrer le 
programme. La liste d’adaptateurs va être automatiquement mise à jour.  
 
Q. Je suis sur un LAN avec un volume de trafic élevé, et j’ai remarqué que CommView augmente la charge du CPU 
et/ou devient moins réceptif. Que puis-je y faire? 

A. La meilleure façon d’optimiser la performance du programme est d’utiliser des règles pour filtrer vers l’extérieur les paquets que 
vous n’avez pas besoin de contrôler.  Par exemple, envoyer un fichier de 50 Meg entre deux machines sur votre LAN peut générer 
approximativement 40,000 paquets NetBIOS avec un taux de transfert de données de 1Mbytes par seconde, lequel peut être une 
charge lourde pour l’application. Mais normalement, vous n’avez pas besoin de visionner tous les paquets NetBIOS envoyés, vous 
pouvez donc configurer CommView pour capturer les paquets IP seulement. CommView a un système flexible de filtres, et vous 
pouvez configurer l’application pour déployer seulement les paquets dont vous avez réellement besoin. Si vous êtes interessé(e) 
dans les informations de statistiques seulement (ces diagrammes verts, graphiques circulaires, et tables d’hôtes), vous pouvez 
utiliser la commande de menu "Suspend packet output", qui vous permet d’avoir les données statistiques sans déploiement de 
paquet en temps réel. Aussi, consultez le chapitre Capturing High Volume Traffic pour plus d’informations. 
 
Q. Quelques fois, lorsque je lance CommView, je vois l’icône hourglass, mais l’application ne démarre pas. Pourquoi?  
A. Soyez certain que vous n’avez pas ouvert la fenêtre de Connexion Properties dans les connexions par modem RTC de réseau 
commuté. Vous ne devriez pas ouvrir cette fenêtre lorsque CommView démarre. Lorsque la fenêtre sera fermée, CommView 
continuera automatiquement à se charger. 
 
Q. Existe-t-il des conflits connus avec tout autre logiciel? 

A. Actuellement, nous savons que des conflits existent avec les programmes suivants:  
 

• ConSeal Private Desktop: Les utilisateurs de CommView peuvent expérimenter des problèmes en ouvrant une connexion 
par modem RTC si CPD opère.  

• McAfee Internet Guard Dog: Il existe un conflit de logiciel de pilotage de bas niveau résultant en un Écran Bleu de la 
Mort.  

• Norton Anti-Virus: Si l’option "Auto-Protect" est activée, CommView peut ne pas lister toutes les cartes réseau disponibles 
sous Windows 98. Ce probème n’est pas confirmé.  

• SoftIce by Numega: Crash de système possible.  
• PGPNet 7.0 par NAI: Il existe un conflit de logiciel de pilotage de bas niveau résultant en un Écran Bleu de la Mort sous 

Windows 2000 si PGPNet est relié à une connexion par modem RTC.  
 
Si vous croyez que vous avez découvert un conflit avec une application ci-dessus non mentionnée, nous apprécierions que vous 
nous en fassiez part.  
  
Q. Dois-je être un professionnel pour utiliser ce programme? 

A. Non. Nous espérons que même les utilisateurs inexpérimentés vont trouver ce programme utile. Vous n’avez pas besoin d’utiliser 
toutes ses caractéristiques. Par exemple, même les novices peuvent être interessés à avoir une image nette des connexions LAN à 
partir et venant de leur ordinateur ou trouver que ce programme installé hier est en fait un Trojan qui envoie vos mots de passe de 
connexion par modem RTC à une certaine adresse de courriel.  
 
Q. Où puis-je trouver un bon FAQ sur la capture de paquets et d’analyseurs de protocole? 

A. Visitez ces sites  
 
Sniffing (network wiretap, sniffer) FAQ 
 
Protocols.com 
 
Q. Y aura-t-il une version française (espagnole, italienne, hollandaise, etc.) de CommView? 

A. Actuellement, nous ne planifions pas lancer aucune version avec interface localisée, mais nous planifions plutôt procurer aux 
utilisateurs des manuels en diverses langues. Vous voulez aider? Traduisez le manuel (le fichier d’aide) qui vient avec le programme 
en une de ces langues et obtenez une licence gratuitement – mais contactez-nous d’abord, s’il-vous-plaît.  
 

ftp://ftp.tamos.com/cv2k_ts.zip
http://www.robertgraham.com/pubs/sniffing-faq.html
http://www.protocols.com/


 

 

 

Capturer un Volume Élevé de Trafic 
 
Lorsque la capture de données d’un segment de réseau large et occupé est en cours, vous devriez garder en tête que procéder des 
milliers de paquets par seconde peut considérablement augmenter l’usage de votre CPU et rendre l’application moins réceptive. Le 
meilleur moyen d’optimiser la performance du programme est d’utiliser des règles pour filtrer vers l’extérieur les paquets que vous 
n’avez pas besoin de contrôler. Par exemple, envoyer un fichier de 50 Meg entre deux machines sur votre LAN peut générer 
approximativement 40,000 paquets NetBIOS, avec une vitesse de transfert de données de 1Mbytes par seconde, laquelle peut être 
une charge lourde pour l’application. Mais normalement, vous n’avez pas besoin de visionner chacun des paquets NetBIOS envoyés, 
et vous pouvez donc configurer CommView pour capturer les paquets IP seulement. CommView a un système de filtres flexible, et 
vous pouvez configurer l’application pour déployer seulement les paquets dont vous avez réellement besoin. Aussi, si vous n’êtes 
interessé(e) qu’en les informations statistiques (ces histogrammes verts, graphiques circulaires et tables d’hôtes), vous pouvez 
utiliser la commande de menu "Suspend packet output", laquelle vous permet d’obtenir les données statistiques sans déploiement 
de paquets en temps réel. 
 
Les facteurs qui améliorent la performance du programme: 

• Un CPU rapide (Pentium III recommandé) 
• Volume RAM (128 et plus recommandé) 
• Un système d’exploitation construit sur la technologie NT (Windows 2000/XP recommandé) 
• Utilisation de règles pour filtrer vers l’extérieur le trafic inutile 
• Utilisation du mode "Suspend packet output" 

 
 
Les facteurs qui diminuent la performance du programme: 

• Un CPU lent ou un volume insuffisant de RAM 
• Utilisation d’alias MAC et IP, spécialement si vous utilisez plusieurs alias 
• Utilisation du nombre de port => conversion en nom de port 

 
 



 

 

 

Travailler avec Plusieurs Instances 
 
CommView peut capturer des paquets de plusieurs adaptateurs de réseau simultanément (non disponible sous Windows 95). Cette 
option est activée en cochant la case Allow Multiple Application Instances dans Settings => Options => Miscellaneous. 
Veuillez s’il-vous-plaît prendre note que vous ne pouvez pas ouvrir le même adaptateur dans deux différentes instances du 
programme. La même limitation s’applique au serveur terminal: deux utilisateurs (locaux ou à distance) ne peuvent capturer le 
trafic du même adaptateur en opérant sur deux instances de CommView sur le même serveur. 
  



 

 

 

Opérer CommView en Mode Invisible 
 
Il y a deux façons d’opérer CommView en processus caché: 
 

1. Lancez CommView avec l’interrupteur "hidden", i.e.:  
 

 CV.EXE hidden 
 

2. Si CommView opère déjà, vous pouvez le cacher/voir en utilisant le "raccourci-clavier". Pour cacher l’application, pressez 
ALT+SHIFT+h. Pour voir l’application, pressez ALT+SHIFT+u. 

 
Rappelez-vous que vous ne pouvez pas complètement cacher toute application dans Windows. Lorsque CommView opère en mode 
invisible, il n’est pas listé dans la liste de tâches (celle qui est invoquée en pressant ALT+CTRL+DEL) sous Windows 95/98/ME, mais 
on peut encore le voir en utilisant tout accessoire qui liste les processus en cours. Sous Windows NT/2000/XP, cet accessoire fait 
partie de Task Manager.  
  



 

 

 

Échanger des Données avec Votre Application 
 
À partir de la version 3.0, CommView procure une interface TCP/IP simple qui vous permet de procéder à la capture de paquets par 
CommView en utilisant votre propre application en temps réel.  
 
Comment ça fonctionne 
Vous devriez lancer CommView avec une ligne de commande aiguillée spéciale, qui dit au programme de "miroiter" les paquets 
capturés à une adresse IP et un port TCP de votre choix.  
 
Exemples: 
CV.EXE miroite:127.0.0.1:5555  // miroite les paquets à l’adresse de retour, TCP port 5555 
CV.EXE miroite:192.169.0.2:10200  // miroite les paquets à 192.169.0.2, TCP port 10200 
 
Lorsque CommView est lancé avec un commutateur (switch) comme celui-ci, il essaie de se connecter à une session TCP, en se 
branchant à une adresse spécifiée et un nombre de port. Ceci veut dire que vous devriez déjà opérer votre application sur un port 
spécifié. Si CommView échoit à établir une connexion, il continuera de tenter de se connecter chaque 15 secondes. La même chose 
se produit lorsqu’une connexion est interrompue: CommView tentera de se connecter chaque 15 secondes. Si la connexion est 
réussie, CommView envoie les paquets qu’il capture à l’adresse IP spécifiée dès qu’ils arrivent, en temps réel. 
 
Format des Données 
Puisque les paquets sont envoyés en vague, et que vous devez être capable d’identifier individuellement les paquets, CommView 
utilise des entêtes simples qui vous permettent de "diviser" la vague en des paquets individuels. Chaque paquet est précédé d’une 
entête de 3-byte. Les deux premiers bytes définissent la longueur du paquet, excluant cette entête. Ces bytes sont dans un ordre 
petit-boutiste standard, i.e. 0x0200 égale 2, et 0x0002 égale 512. le troisième byte signifie la direction du paquet: 
 
0x00 – passant à travers 
0x01 - entrant 
0x02 – sortant 
 
Exemples: 
 
0xE80000 – un paquet passant à travers, de 232 bytes de longueur 
0xB10102 – un paquet sortant, de 433 bytes de longueur 
 
En vous basant sur cette description, vous pouvez facilement créer un trieur de paquets qui extraierait les paquets de la vague.  
 
Projets Échantillons 
Deux simples applications démonstratives, qui écoutent les connexions entrantes, extraient les paquets d’une vague, puis déploient 
les données indéfinies qui sont disponibles. 
 

• http://www.tamos.com/products/commview/samp_mirr_c.zip. Ceci est un projet Visual Studio avec C++ comme source 
code. 

 
• http://www.tamos.com/products/commview/samp_mirr_d.zip. Celui-ci est un projet Delphi avec Pascal comme source 

code. Si vous voulez compiler ce projet, vous aurez besoin de la populaire suite de composants ICS par François Piette 
disponible au http://overbyte.alexid.fr/. 

 
Bande Passante (Bandwidth) 
Lorsque vous miroitez des données d’un ordinateur à distance, soyez certain(e) que que le lien entre CommView et l’ordinateur sur 
lequel les données sont miroitées est assez rapide pour transférer toutes les données capturées. 500 Kbytes/sec, et que votre lien 
ne peut traiter que 50 Kbytes/sec, vous allez inévitablement avoir des "embouteillages de trafic", ce qui pourrait résulter en des 
problèmes variés (par exemple, Winsock peut seulement arrêter l’envoi de données sous certaines versions Windows). Si vous 
recherchez une solution plus flexible qui incluerait des caractéristiques de mémoire tampon intelligente et de contrôle à distance, 
considérez l’utilisation de CommView Remote Agent. 

http://www.tamos.com/products/commview/samp_mirr_c.zip
http://www.tamos.com/products/commview/samp_mirr_d.zip
http://overbyte.alexid.fr/


 

 

 
Information 
 
Comment se Procurer CommView 
 
Ce programme est une version d’évaluation de 30 jours. Ci-dessous se trouvent les prix pour le programme entièrement fonctionnel 
et sans restriction:  
 

Type de Licence 
 

Prix, US$ 

CommView Home License 1 utilisateur 
(pour privé, usage non commercial) 
 

99.00 

CommView Enterprise License 1 utilisateur 
(pour professionnel, usage commercial) 
 

249.00 

 
 

• La licence la moins dispendieuse, Home License, vous donne le droit d’utiliser le programme à la maison pour des fins 
non commerciales. Si vous utilisez CommView pour contrôler votre réseau maison, le nombre maximum d’hôtes dans 
votre LAN que cette licence vous permet ne peut excéder cinq.   

 
• La licence la plus dispendieuse, Enterprise License, vous donne droit d’utiliser le programme n’importe où pour des fins 

commerciales ou non commerciales.  
 
Une copie licenciée de CommView peut être utilisée par une seule personne qui utilise le logiciel personnellement sur un ou 
plusieurs ordinateurs ou le logiciel peut être installé sur une seule station de travail utilisée non simultanément par plus d’une 
personne, mais pas les deux.  Visitez notre site web pour les prix sur les licences pour multiples usagers si vous avez besoin de faire 
l’achat de ce produit pour plus d’un utilisateur.  
 
 
En tant qu’utilisateur enregistré, vous recevrez: 
 

• Une copie du logiciel entièrement fonctionnelle et sans restriction 
• Des mises à jour gratuites qui seront lancées durant l’année suivant la date d’achat 
• De l’information sur les mises à jour et les nouveau produits 
• Un support technique gratuit 

 
Nous acceptons les commandes par cartes de crédit, les commandes par téléphone et télécopieur, les chèques, les commandes par 
mandat ou ordre et les transferts de fonds. Les prix, les termes et les conditions sont sujets à changement sans aucune forme de 
préavis : veuillez s’il-vous-plaît visiter notre site web pour les dernières offres de produits et les derniers prix. 
 
http://www.tamos.com/order/ 
 

http://www.tamos.com/order/


 

 

 
Contactez-Nous 
 
Web 
 
http://www.tamos.com  
 
 

E-mail 
 
 
sales@tamos.com (Questions reliées aux ventes)  
support@tamos.com (Toutes les autres questions)  
 
 
Courrier postal et Télécopieur 
 
Adresse postale: 
 
PO Box 1385 
Christchurch 8015 
New Zealand  
 
Fax: +64 3 359 0392 (New Zealand) 
Fax: +1 503 213-7764 (USA) 
 
 
 

http://www.tamos.com/
mailto:sales@tamos.com
mailto:support@tamos.com


 

 

 
Autres Produits par TamoSoft 
 
SmartWhois 
 
SmartWhois est un accessoire utilitaire pour obtenir de l’information sur toute adresse IP, nom d’hôte ou de domaine dans le monde 
entier. Contrairement à d’autres utilitaires whois standards, il délivre automatiquement l’information associée à une adresse IP ou à 
un domaine, peu importe où il est géographiquement enregistré. En seulement quelques secondes, vous obtenez toute l’information 
que vous désirez connaître sur un utilisateur: domaine, nom de réseau, pays, état ou province et ville. Même si l’adresse IP ne peut 
pas être convertie en nom d’hôte, SmartWhois n’échouera pas! 
 
Plus d’informations 
 
Essential NetTools 
 
Essential NetTools est un kit d’outils de réseau utile pour diagnostiquer les réseaux et contrôler les connexions réseau de votre 
ordinateur. C’est un véritable couteau d’armée suisse pour toute personne intéressée dans un kit d’outils de réseau puissant pour 
usage quotidien. Le programme inclut un utilitaire NetStat qui montre les connexions réseau de votre ordinateur et ouvre les ports 
et les cartes à cette propre application. Il contient aussi un scanner NetBIOS rapide, un outil d’audition NetBIOS pour vérifier la 
sécurité LAN, ainsi qu’un contrôle de connexions externes aux ressources partagées de votre ordinateur, puis un contrôle de 
processus qui déploie l’information sur tous les programmes et services opérant sur votre ordinateur. D’autres outils utiles sont 
aussi inclus, tells que Ping, TraceRoute, et NSLookup. Des accessoires additionnels incluent un générateur de rapports en HTML, en 
texte, et en format délimité par des virgules et une interface conventionnelle. Le programme est un remplacement puissant et facile 
à utiliser pour les utilitaires Windows tels que nbtstat, netstat, et NetWatcher. Il incorpore plusieurs accessoires avancés que les 
outils standards Windows ne peuvent offrir. 
 
Plus d’informations 
 
 
DigiSecret 
 
DigiSecret est une application sécuritaire et facile à utiliser pour l’encryptage et la partage de fichiers. Elle utilise des algorithmes 
d’encryptage forts et prouvés pour créer des archives encryptées, des fichiers auto-extractibles EXE, et partager des fichiers avec 
vos associés et vos amis. DigiSecret inclut aussi un compresseur de fichier puissant et intelligent; vous n’avez maintenant plus 
besoin de fichiers .zip lorsque vous pouvez avoir encrypté ou compressé  les fichiers DigiSecret. Le programme est integré avec le 
Shell de Windows, et vous pouvez performer des opérations sur des fichiers en cliquant le bouton droit de la souris sur ceux-ci.  Le 
programme supporte aussi entièrement les opérations de glisser-déposer. 
 
Plus d’informations 
 

http://www.tamos.com/products/smartwhois/
http://www.tamos.com/products/nettools/
http://www.tamos.com/products/digisecret/
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